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Copyright
Copyright © 2006 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 RM-133/RM-132 product selection
The Nokia RM-133 is a GSM/WCDMA dual mode handportable phone supporting EGSM 850/900/1800/1900
and WCDMA 2100 (UMTS). The RM-132 variant does not support WCDMA radio interface and related services.

Note: All subsequent references to WCDMA or related services concern RM-133 only.

RM-133 is a 3GPP Release 99H terminal supporting WCDMA, EGPRS and GPRS data bearers. For WCDMA the
maximum bit rate is up to 384 kbps for downlink and 384 kbps for uplink with simultaneous CS speech (64
kbps). For GSM networks RM-133 supports EGPRS multislot class 11 (4+3, max 5) and DTM multislot class 9 (3
+2, max 5).

The handset has a full phase 2 Type Approval and complies with the GSM Type Approval. It has a full CE approval
and FCC approval.

RM-133 supports two way video calls with two integrated cameras. Nokia RM-133 is an MMS (Multimedia
Messaging Service) enabled phone with a large bright colour display and an integrated 3.2 megapixel digital
camera. The MMS implementation follows the OMA MMS standard release 1.2. The WAP 2.0 compatible
Browser supports XHTML Mobile Profile (MP) and uses a TCP/IP stack to communicate with a gateway in
network.

The handset uses Symbian 9.1 operating system and supports also MIDP Java 2.0 & CLDC1.1, providing an
excellent platform for 3rd party applications.

Figure 1 View of RM-133/RM-132

 Product features and sales package

Display and user interface
• QVGA display (240x320, up to 262,144 colours)

• Automatic brightness control for display

• 4-way scroll key with center select, two softkeys, application-key, edit and clear key, send & end key,
multimedia key

• Dedicated capture key, zoom/volume keys and review key

• System: EGSM 850/900/1800/1900 + WCDMA 2100 GHz
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• User interface: S60 software on Symbian OS

Imaging and video
• Integrated 3.2 Megapixel camera with up to 20 x digital zoom and mechanical shutter

• Landscape capture with dedicated capture key

• Integrated Flash LED with red-eye reduction function

• High-quality video capture in MP4 and 3GP formats with up to 8x digital zoom

• Image and video editors

• Nokia Lifeblog

• Image and video uploading to the web

• XpressPrint over infrared, Bluetooth wireless technology, PictBridge and UPnP directly from Gallery

Entertainment
• Integrated digital music player with stereo audio. Supported file formats: MP3, AAC, eAAC+ and wma

• USB mass storage that enables easy drag and drop of files, such as music tracks

• Stereo FM radio with support for Visual Radio

• Multimedia player (RealPlayer) with 3GPP & MPEG4 AVC video streaming support

• Internet browser

Productivity
• Office document viewers (Microsoft Word, PowerPoint, Excel) and PDF reader

• PC Suite connectivity with USB, Bluetooth wireless technology, and IrDa

• Advanced S60 PIM (calendar, contacts, task list, PIM printing, etc.)

• Voice recording, dialing and voice commands

• Push to talk (PoC) application

• SettingWizard for easy settings configuration

• Video sharing and two-way video call

Messaging
• E-mail with document viewers to view attachments

• SMS, multimedia messaging (MMS)

Memory functions
• Up to 42 MB of internal dynamic memory for images, contacts, text messages, multimedia messages,

ringing tones, images, video clips, calendar notes, to-do list and applications. Please note that the
preinstalled applications on the user data area of the device memory will reduce the informed amount of
available memory, unless uninstalled.

• Expandable memory: 1 GB miniSD card. *

• Hot swap slot for easy memory card insertion and removal

*The availability of a memory card and memory capacity of the card in the sales package may vary depending
on the market and/or your network operator/service provider.

Connectivity
• Bluetooth wireless technology
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• Infrared

• Pop-Port™ with USB 2.0 Full Speed with mass storage class

Operating frequency and data transfer
• WCDMA2100 and quadband GSM/EDGE (EGSM 850/900/1800/1900) WCDMA2100 with simultaneous voice

and packet data (PS max speed UL/DL= 384/384 kbps, CS max speed 64 kpbs)

• EGPRS (Class A, Multislot class 11) – Max download 236.8 kbps; upload 118.4 kbps

• Data transfer (from compatible S40 and S60 phones)

Java
• Java™ MIDP 2.0, CLDC 1.1

• Over-the-air download of Java™-based applications and games

Sales package
• Transceiver

• Charger (AC-4)

• Battery (BP-6M)

• Stereo headset (HS-23)

• Connectivity cable (CA-53)

• Wrist strap (CP-134)

• Charging adapter (CA-44)

• Lens cleaning cloth

 Mobile enhancements

Table 1 Audio

Enhancement Type

Classic stereo headset HS-23

Music stereo headset HS-28+AD-41

Mono Headset HS-5

Boom Headset HDB-4

Fashion Stereo Headset HS-31

Display Headset HS-69

Bluetooth headset BH-800 HS-24W

Bluetooth Headset BH-900 HS-25W

Wireless Headset HS-26W

Wireless Headset HS-11W

Wireless Clip-on Headset HS-21W

Wireless Headset HS-36W

Wireless Headset HS-37W

Wireless Headset HS-53W
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Enhancement Type

Wireless Headset HS-55W

Wireless Headset HS-54W

Wireless Headset HS-56W

Bluetooth Headset BH-200 HS-58W

Bluetooth Headset BH-700 HS-57W

Bluetooth Headset BH-300 HS-50W

Bluetooth Headset BH-600 HS-59W

Audio Adapter AD-15

Audio Adapter AD-46

Music Stand MD-1

TTY Adapter HDA-10

Loopset LPS-4

Table 2 Car

Enhancement Type

Mobile charger DC-4

Headrest handsfree BHF-3

Basic handsfree HF-3

Advanced car kit (sales pack) CK-7W

Nokia 616 car kit N616

Basic car kit CK-10

Wireless plug-in car handsfree HF-6W

Universal holder CR-39

Table 3 Carrying

Enhancement Type

Multicompatible carrying case CP-93

Inbox strap CP-134

Lens cloth CL-3

Table 4 Data

Enhancement Type

Mini SD card 128 MB MU-17

Mini SD card 256 MB MU-18
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Enhancement Type

Mini SD card 512 MB MU-23

Mini SD card 1GB MU-24

Charging connectivity cable CA-70

Connectivity cable CA-53

Table 5 Deskstands

Enhancement Type

Universal passive deskstand DT-13

Table 6 Imaging

Enhancement Type

Nokia image album PD-1

Nokia remote camera PT-6

Table 7 Messaging

Enhancement Type

Nokia digital pen SU-1B

Bluetooth QWERTY keypad SU-8W

Table 8 Positioning

Enhancement Type

Wireless GPS Module LD-1W

Wireless GPS Module update LD-3W

Table 9 Power

Enhancement Type

Battery 1100 mAh Li-ion BP-6M

Compact charger AC-3

Travel charger AC-4

Charging adapter CA-44
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 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with BP-6M
1100 mAh li-ion battery
back

110 x 49 x 19 (26 mm at
camera)

116 89

Main RF characteristics for GSM850/900/1800/1900 and WCDMA 2100 phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA 2100

Rx frequency band GSM850: 869 - 894MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA2100: 2110 - 2170 MHz

Tx frequency band GSM850: 824 - 849MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA2100: 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA -50 … 24 dBm

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16
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Battery endurance

Battery Capacity (mAh) Talk time Stand-by

BP-6M 1100 273 mins (GSM)

up to 226 mins (WCDMA)

up to 318 hours (GSM)
and up to 348 hours
(WCDMA)

Charging times

AC-4

up to 90 min

Environmental conditions

Environmental condition Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -25oC...-15oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-15oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC
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 Mechanical spare parts list

• Bold = assembly (assy)

• I0xx = ITEM codes for upper or mono block

• I1xx = ITEM codes for hinge block

• I2xx = ITEM codes for lower block

• I3xx = ITEM codes for soldered spare parts in the upper hinge or lower block and not exchangeable

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

ITEM/ CIRCUIT
REF. QTY PART NAME

I001 1 A-COVER

I002 1 KEYMAT

I003 6 SCREWS

I004 1 DISPLAY SHIELD

I005 1 DISPLAY

I006 1 SCREW

I007 1 LIGHT GUIDE

A1 1 UI MODULE ASSEMBLY (I008 - I010)

I008 1 DOMESHEET

I009 1 UI MODULE

I010 1 JOYSTICK HAT

I011 1 CAMERA BOOT

I012 1 FRONT CAMERA

A2 1 UI FRAME ASSEMBLY (I013 - I017)

I013 1 GASKET-EARPIECE

I014 1 UI FRAME

I015 1 EARPIECE ADHESIVE

I016 1 EARPIECE

I017 1 BASEBAND GASKET

I018 1 MAIN CAMERA

I019 1 LID WCDMA

I020 1 LID GSM

I021 1 ENGINE MODULE

I022 1 BATTERY FLOOR INSULATOR

I023 1 TYPE LABEL

I024 1 SD CARD DOOR

RM-132; RM-133
Nokia Customer Care Parts Lists and Component Layouts

Page 2 –6 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



ITEM/ CIRCUIT
REF. QTY PART NAME

A3 1 ANTENNA MODULE ASSEMBLY (I025 - I029)

I025 1 IHF SPEAKER

I026 1 FLASH LED

I027 1 ANTENNA MOULDING

I028 1 ANTENNA

I029 1 POWER DOME

A4 1 B-COVER ASSEMBLY (I030 - I040, I045)

I030 1 GASKET-IHF HOUSING

I031 1 IHF SPEAKER 2

I032 IHF GASKET 2

I033 1 MICROPHONE

I034 1 DC JACK

I035 2 SLIDE DETECT POGO PIN

I036 1 POWER KEY

I037 1 VOLUME KEY

I038 1 CAMERA MODE KEY

I039 1 CAMERA KEY

I040 1 CAMERA KEY SPRING

I045 1 WATER INGRESS LABEL

A5 1 SLIDE COVER ASSEMBLY (I041 - I044)

I041 1 C-COVER RELEASE BUTTON

I042 1 SLIDE DETECT FLEXI ASSY

I043 1 SLIDE MECHANISM

I044 1 SLIDE COVER

 Component parts lists and layouts

Component parts lists

Table 10 RM-133 component part list (1SU_11)

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

A7002 Top H 17 SHIELD_0264350
SHIELD RF ASSY
040-021698 ~ ~

A7003 Top B 19 SHIELD_0264351
SHIELD WCDMA ASSY
040-021699 ~ ~
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Item Side Grid ref. Type Description and value

B2200 Top C 5
CRYSTAL_3.3X1.6
_H0.9

CRYSTAL 32.768KHZ
+-30PPM 12.5PF

32.768kH
z ~

C1100 Bot H 15 0402C Chipcap 5% NP0 10p 50V

C1101 Bot H 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2005 Bot F 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2006 Bot F 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2007 Top F 2 0402C Chipcap 5% NP0 10p 50V

C2008 Top F 2 0402C Chipcap 5% NP0 10p 50V

C2009 Top G 2 0402C Chipcap 5% NP0 10p 50V

C2010 Top G 2 0402C Chipcap 5% NP0 10p 50V

C2012 Bot C 4 0603C_H0.95
CHIPCAP X5R 1U K 25V
0603 1u0 25V

C2202 Top C 4 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2203 Top B 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2204 Top A 4 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2206 Top C 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2210 Bot E 3 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2211 Top A 5 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2212 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2213 Top C 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2215 Top B 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2217 Top B 4 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C2220 Top A 4 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2222 Top A 5 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V
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Item Side Grid ref. Type Description and value

C2228 Top B 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2250 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2251 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2300 Top G 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2304 Top F 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2306 Top G 5 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2314 Top H 7 0805C
CHIPCAP X5R 4U7 M 25V
0805 4u7 25V

C2316 Top H 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2317 Top G 5 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C2700 Bot D 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2800 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2801 Top F 9 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2802 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2803 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2804 Top G 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2805 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2806 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2809 Top F 9 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C3503 Top B 9 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C4201 Top B 14 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3

C4401 Top F 20 0402C Chipcap 5% NP0 27p 50V
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Item Side Grid ref. Type Description and value

C4403 Top C 9 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C4404 Top C 8 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C4405 Top G 11 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C4409 Top I 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4420 Bot A 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4800 Top E 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4801 Top F 9 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4803 Top C 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4808 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5002 Top F 6 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5100 Top C 10 0402C Chipcap 5% NP0 27p 50V

C6031 Top B 7 0402C Chipcap 5% NP0 18p 50V

C6032 Top B 7 0402C Chipcap 5% NP0 100p 50V

C6033 Top B 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6034 Top A 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6035 Top C 6 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6036 Top C 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6037 Top C 7 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6038 Top B 6 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6039 Top A 6 0402C Chipcap 5% NP0 18p 50V

C6051 Top B 7 0402C Chipcap +-0.25pF NP0 2p7 50V

C6052 Top B 7 0402C Chipcap +-0.25pF NP0 2p7 50V

C6055 Top A 7 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V
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Item Side Grid ref. Type Description and value

C6100 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6101 Top A 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6102 Top A 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6103 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6104 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6105 Top C 2 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6108 Top C 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6109 Top A 2 0402C Chipcap 5% NP0 47p 50V

C6110 Top B 2 0402C Chipcap 5% NP0 27p 50V

C6112 Top B 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6113 Top A 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6502 Bot B 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6503 Bot B 17 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6508 Top E 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6509 Top C 13 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6510 Top B 13 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6515 Top B 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6516 Top C 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6590 Top D 13 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6592 Top B 14 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C6593 Top C 15 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3
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C6594 Top A 16 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6595 Bot B 17 0805C
CHIPCAP X5R 4U7 M 25V
0805 4u7 25V

C6598 Top I 12 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C7500 Top I 17 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7501 Top G 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7502 Top G 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7504 Top I 17 0402C Chipcap +-0.25pF NP0 2p2 50V

C7505 Top G 14 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C7507 Top I 17 0402C Chipcap +-0.25pF NP0 1p5 50V

C7508 Top H 14 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7509 Top H 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7510 Top G 14 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7511 Top D 14 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3

C7512 Top A 18 0402C Chipcap 5% NP0 27p 50V

C7513 Bot F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7514 Bot F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7515 Top G 19 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7516 Bot C 19 0402C Chipcap +-0.25pF NP0 6p8 50V

C7517 Bot C 19 0402C Chipcap 5% NP0 10p 50V

C7518 Top D 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7519 Bot C 19 0402C Chipcap 5% NP0 27p 50V

C7520 Bot C 19 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7521 Bot C 19 0402C
Chipcap X7R 10% 50V
0402 1n0 50V
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C7523 Top I 14 0402C Chipcap +-0.25pF NP0 3p3 50V

C7525 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7526 Top H 14 0603C
CHIPCAP NP0 2N2 G 16V
0603 2n2 16V

C7527 Top H 14 0402C
CHIPCAP NP0 470P J 6V3
0402 470p 6V3

C7528 Bot B 16 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7529 Top A 18 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7530 Top B 18 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7531 Top B 19 0402C Chipcap 5% NP0 10p 50V

C7532 Top B 18 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7533 Top A 20 0402C
CERCAP X7R 22N K 16V
0402 22n 16V

C7534 Top D 19 0402C Chipcap 5% NP0 27p 50V

C7537 Bot E 15 0402C Chipcap 5% NP0 10p 50V

C7538 Bot G 16 0402C Chipcap 5% NP0 10p 50V

C7539 Top B 15 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7540 Top I 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7542 Top H 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7543 Top I 17 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7546 Top C 12 0402C Chipcap 5% NP0 27p 50V

C7547 Top E 13 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C7548 Top F 14 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C7549 Top F 7 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7550 Top G 7 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7551 Top C 14 0402C
Chipcap X7R 10% 16V
0402 10n 16V
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C7553 Top I 19 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7563 Top I 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7564 Top B 20 0402C Chipcap 5% NP0 27p 50V

C7565 Top A 14 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7567 Bot D 3 0402C Chipcap 5% NP0 27p 50V

C7568 Top B 3 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C7569 Bot E 5 0402C Chipcap 5% NP0 27p 50V

C7570 Bot D 4 0402C Chipcap 5% NP0 27p 50V

C7571 Bot D 5 0402C Chipcap 5% NP0 27p 50V

C7572 Top B 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7573 Top C 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7590 Top D 20 0402C Chipcap 5% NP0 27p 50V

C7591 Top F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7592 Top F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7598 Top H 18 0402C Chipcap +-0.25pF NP0 2p2 50V

C9059 Top E 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C9060 Bot C 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C9070 Top C 13 0402C Chipcap 5% NP0 27p 50V

C9071 Top A 16 0402C
CHIPCAP X5R 1U K 6V3
0402 1u0 6.3V

C9073 Top C 10 0402C Chipcap 5% NP0 27p 50V

C9074 Top C 16 0402C Chipcap 5% NP0 27p 50V

C9075 Top D 14 0402C Chipcap 5% NP0 27p 50V

C9076 Top H 11 0402C Chipcap 5% NP0 27p 50V

C9077 Top I 12 0402C Chipcap 5% NP0 27p 50V

C9078 Top H 13 0402C Chipcap 5% NP0 27p 50V

C9079 Top F 10 0402C Chipcap 5% NP0 10p 50V

C9080 Top B 4 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V
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C9083 Top H 13 0402C Chipcap 5% NP0 47p 50V

C9084 Bot G 17 0402C Chipcap 5% NP0 56p 50V

C9085 Bot G 16 0402C Chipcap 5% NP0 56p 50V

C9086 Bot H 16 0402C Chipcap 5% NP0 56p 50V

C9087 Top B 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C9088 Top G 13 0402C Chipcap 5% NP0 33p 50V

C9090 Top A 13 0402C Chipcap 5% NP0 27p 50V

C9093 Bot C 19 0402C Chipcap +-0.25pF NP0 3p3 50V

D2800 Top H 9 VFBGA343 RAP3GS V2.0E-PA VFBGA ~ ~

D5000 Top E 7
FBGA133_11.6X1
3.1

COMBO 512 DDR + 1G
NAND FBGA133 PBFREE

32Mx16/1
28Mx8 ~

D6500 Top D 11 FBGA_195
OMAP DM290
GOLDENEYE NFBGA ~ ~

D6501 Top F 11
WBGA_60_8.1X6.
6_H0.9

SDRAM 4X16 1.8V/1.8V
FBGA60 PBFREE 4Mx16 ~

D6502 Top H 9 FBGA128_EMPTY

COMBO 128M NOR
+128M DDR DRAM
FBGA128

8Mx16/8
Mx16 ~

D6503 Top B 15
uBGA_6_1.45X0.9
5

SN72AUC2G04YZT INV
GATE WCSP06 ~ ~

F2000 Bot C 3
0603_FUSE_AVX2
MATS SM FUSE F 2.0A 32V 2A ~

G1000 Bot B 15 BATTER_EECEP
RTC BACUP CAPAC 311
SIZE FOR 2.6V 4UAH 2.6V ~

G7500 Top G 14 NKG3176B_H1.0
VCTCXO 38.4MHZ 2.5V
2MA 38.4MHz ~

G7501 Top I 14 VCO_DCS02733
VCO 3296-3980MHZ 4-
BAND MATSUSHITA

3296-398
0MHz ~

J7500 Bot C 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

J7502 Bot C 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

J7590 Bot D 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

L2000 Bot C 3 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2002 Bot E 3 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~
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L2003 Bot E 2 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2004 Bot E 2 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2011 Bot G 2 COIL_LK_1608
CHIP COIL 68NH J
Q12/100MHZ 0603 68nH ~

L2302 Top G 8
CHOKE_SER400_H
1.2

INDUCT WW 10UH 0A65
0R35 4X4X1.2 10uH ~

L2309 Top H 6
CHOKE_SER300_H
1.5

CHOKE 22U M 0R7 0.35A
3.0x3.0x1.5 22uH ~

L3002 Bot A 4 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6030 Top B 7 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6031 Top B 7 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6032 Top B 6 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L6100 Top B 3 0402LQW
CHIP COIL 47N +-3%
Q25/200MHZ 0402 47nH ~

L6101 Top A 2 0402L_POL2
CHIP COIL 120NH J
Q8/100MHZ 0402 120nH ~

L6500 Top C 14 CHOKE_SER300
INDUCT WW 2.2UH 1A2
310 CASE SIZE 2u2H ~

L6501 Bot B 16
CHOKE_SER300_H
1.5

CHOKE 3U3 1.2A 0R096
3X3X1.5 3u3H ~

L6502 Top E 14 CHOKE_SER300
INDUCT WW 2.2UH 1A2
310 CASE SIZE 2u2H ~

L6505 Top B 13
CHOKE_SER400_H
1.2

INDUCT WW 10UH 0A65
0R35 4X4X1.2 10uH ~

L6509 Top B 4 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L6517 Top G 3 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6518 Top F 3 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6519 Bot G 16 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6520 Bot G 16 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~
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L6521 Top E 3 0405_2_TDK
CHIP BEAD ARRAY
2X220R 0405 2x220R ~

L6522 Bot F 3 0405_2_TDK
CHIP BEAD ARRAY
2X220R 0405 2x220R ~

L6600 Bot C 17 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6604 Bot B 17 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7500 Top I 16 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7520 Top G 19
FERRITE_FBMJ160
8

FERRITE BEAD 0R01
28R/100MHZ 0603

28R/
100MHz ~

L7540 Top B 18
CHOKE_SER300_H
1.5

CHOKE 3U3 1.2A 0R096
3X3X1.5 3u3H ~

L7541 Top B 20 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L7542 Bot C 20 0402L
CHIP COIL 12N J
Q31/800M 0402 12nH ~

L7544 Top C 3 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7545 Top G 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7546 Top F 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7547 Bot F 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7548 Bot F 20 0402L_XL
CHIP COIL 68N J
Q17/300M 0402 68nH ~

L7549 Bot F 20 0402L_XL
CHIP COIL 68N J
Q17/300M 0402 68nH ~

L7551 Top E 20 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7553 Bot B 18 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7599 Top H 18 0402L_H0.45
CHIP COIL 4N7 +-0N1
Q29/1GHZ 0402 4n7H ~

L7601 Top I 17 0402L
CHIP COIL 8N2 J
Q28/800MHZ 0402 8n2H ~

L7603 Top I 17 0402L
CHIP COIL 18N J
Q29/800M 0402 18nH ~
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L7604 Top D 19 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7605 Top D 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7606 Top I 18 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H 50V

L7607 Bot B 5 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L7608 Bot A 5 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L7609 Top I 13 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L7610 Bot F 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7611 Bot F 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L9056 Bot E 6 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L9057 Top F 10 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L9060 Top G 13 0603L
CHIP COIL 470N+-2%
Q30/100MHZ 0603 470nH ~

L9097 Bot C 19 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

M1000 Bot B 3
VIBRA_M_KHN4N
X1RA

SMD VIBRA MOTOR 1.3V
80MA 9000RPM ~ ~

N2200 Top B 5 TFBGA_105
AVILMA 1.05C BB
MODULE TFBGA105 ~ ~

N2300 Top G 6 TFBGA64_H1.2 BETTY V2.1 LF TFBGA64 ~ ~

N3500 Top C 9
USMD5_1.47X1.0
4_H0.675

VREG LP3985ITLX-3.0
NOPB USMD5 ~ 3V

N3501 Top C 10 PBGA_N20_P0.5

LEVEL SHIFT
SN74AVCA406LZXYR S-
PBGA-N20 *FOR NRC USE
ONLY* ~ ~

N4800 Top E 9 uBGA_289
HELEN3 PS2.0 N3
F761909 C27 UBGA289 ~ ~

N6030 Top B 7
CSP_47_3.85X4.0
5 BC4-ROM1.0RDL ~ ~

N6100 Top B 3
WFBGA34_2_3.57
X3.57

FM RECEIVER
TEA5761UK N4B CSP (TI) ~ ~
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N6502 Bot A 17 TK11892F

STEP-UP DC/DC CONV
TK11892F-G-20
SON3024-8 ~ ~

N6505 Bot A 16
IRDA_TFBS_GP2W
_CIM IRDA MIR XSMALL ~ ~

N6508 Top E 13
USMD5_1.417X1.
087

DC/DC CONV
LM3671TLX-1.82V
USMD5 ~ ~

N6509 Bot E 3 XBGA_N16
AF AMP TPA2012D2
77DB/217HZ WCSP16 ~ ~

N6513 Top C 14
USMD_8_1.55X1.
55

2XVREG 2.8V/150MA
LP3986 USMD8 PB-FREE ~ 2.8V

N6515 Top B 14
USMD_10_2.458X
1.899

DC/DC CONV
LM3661-1.40V/1.05V
NOPB ~ ~

N6516 Top B 15 ECSP2828_10
SHUTTER DRIVER
LB8681CL ~ ~

N6517 Top B 13
XBGA_N8_2.02X1.
02

DC/DC CONV
TPS6231YZD 1.5V CSP8 ~ ~

N6518 Top E 13
USMD5_1.468X1.
036

REG+ LP3999ITLX 1.8V
150MA NOPB ~ 1.8V

N6519 Top F 14 FC_4_0.99X0.99
LI VREG 1.5V/150MA
WLCSP4 TK63115B ~ 1.5V

N7500 Top H 16 TFBGA_188_H1.4
RF SYSTEM MODULE
PIHI2.22 9.0X9.0X1 ~ ~

N7520 Top H 19 RF9282E3.6

PA RF9282E6.3 GSM/
EDGE
850/900/1800/1900 ~ ~

N7540 Top B 19 RF9372_H1.5
PA MODULE RF9372E5.2
WCDMA 1850-1980MHZ ~ ~

N7541 Top B 18
uBGA8_1.849X1.
696

DC CONV LM3202TLX
NOPB REVB USMD8 ~ ~

N7542 Top I 12
USMD5_1.47X1.0
4_H0.675

VREG LP3985ITLX-2.8
NOPB USMD5 ~ 3V

N9002 Top H 7
USMD8_1.69X1.6
9

WHITE LED DRIVER
4LEDS 500MW 8BUMP
USMD8 ~ ~

N9003 Top F 3
uBGA_6_1.45X0.9
5

TI ANALOG SWITCH
TS5A3159YZTR WCSP06 ~ ~

N9004 Top G 3
uBGA_6_1.45X0.9
5

TI ANALOG SWITCH
TS5A3159YZTR WCSP06 ~ ~
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Item Side Grid ref. Type Description and value

N9006 Top B 16 FC_4_0.99X0.99
LI VREG 1.5V/150MA
WLCSP4 TK63115B ~ 1.5V

R1100 Bot G 16 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R1101 Bot E 5 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R1102 Bot H 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2006 Top G 2 BGA11
ASIP 4 LINES AUDIO
FILTER BGA11 ~ ~

R2007 Bot E 3
uBGA11_1.6X2.1
5

ASIP SILIC USB OTG / ESD
BGA11 ~ ~

R2009 Top G 5 0402R Resistor 5% 63mW 220k ~

R2303 Top H 7 0402R Resistor 5% 63mW 27R ~

R2800 Top H 8 0402R Resistor 5% 63mW 10R ~

R2801 Top F 10 0402R Resistor 5% 63mW 4k7 ~

R2804 Top G 8 0402R Resistor 5% 63mW 4k7 ~

R2805 Top H 8 0402R Resistor 5% 63mW 4k7 ~

R4400 Bot D 5 0402R Resistor 5% 63mW 470k ~

R4401 Top F 20 0402R Resistor 5% 63mW 100k ~

R4402 Bot D 5 0402R Resistor 5% 63mW 470k ~

R4403 Top F 20 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R4410 Bot C 5 0402R Resistor 5% 63mW 47k ~

R4416 Top B 10 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4420 Bot F 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4800 Top E 8 0402R Resistor 5% 63mW 10R ~

R4801 Top F 10 0402R Resistor 5% 63mW 1k0 ~

R6030 Top C 7 0402R Resistor 5% 63mW 10k ~

R6031 Top B 6 0402R Resistor 5% 63mW 10k ~

R6032 Top C 7 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R6034 Top B 7 0402R Resistor 5% 63mW 10k ~

R6037 Top A 6 0402R Resistor 5% 63mW 100k ~

R6100 Top B 3 0402R Resistor 5% 63mW 10k ~

R6101 Top B 3 0402R Resistor 5% 63mW 100k ~
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R6102 Top C 3 0402R Resistor 5% 63mW 4k7 ~

R6103 Top C 3 0402R Resistor 5% 63mW 4k7 ~

R6505 Bot A 18 0402R Resistor 5% 63mW 10k ~

R6506 Bot A 17 0402R Resistor 5% 63mW 10k ~

R6507 Bot B 17 0402R
CHIPRES 0W06 3R3 J
0402 3R3 ~

R6508 Bot A 17 0402R
CHIPRES 0W06 3R3 J
0402 3R3 ~

R6510 Top E 12 0402R Resistor 5% 63mW 100R ~

R6512 Top D 12 0402R Resistor 5% 63mW 100R ~

R6513 Top E 12 0402R Resistor 5% 63mW 2k2 ~

R6516 Top G 11 0402R Resistor 5% 63mW 100R ~

R6517 Top D 12 0402R Resistor 5% 63mW 100R ~

R6519 Top D 13 0402R Resistor 5% 63mW 10R ~

R6520 Top B 13 0402R Resistor 5% 63mW 10R ~

R6590 Top D 12 0402R Resistor 5% 63mW 100R ~

R6599 Top C 12 0402R Resistor 5% 63mW 100R ~

R7000 Top F 14 0402R Resistor 5% 63mW 47R ~

R7501 Top H 15 0402R Resistor 5% 63mW 22k ~

R7502 Top H 13 0402R Resistor 5% 63mW 330R ~

R7504 Top I 17 0402R Resistor 5% 63mW 4k7 ~

R7505 Top H 13 0402R Resistor 5% 63mW 27k ~

R7507 Top G 13 0402R
CHIPRES 0W06 1K5 F
100PPM 0402 1k5 ~

R7509 Top G 18 0402R Resistor 5% 63mW 27k ~

R7514 Top C 18 0402R Resistor 5% 63mW 47k ~

R7515 Top I 15 0402R
Chipres 0W06 5R6 J
0402 5R6 ~

R7516 Top H 14 0402R
CHIPRES 0W06 8K2 F
0402 8k2 ~

R7517 Top H 14 0402R
CHIPRES 0W06 1K0 F
200PPM 0402 1k0 ~

R7518 Top C 19 0402R Resistor 5% 63mW 10R ~

R7520 Top A 17 0402R
CHIPRES 0W06 1K2 F
250PPM 0402 1k2 ~

R7521 Top A 19 0402R
Chipres 0W06 jumper
0402 0R ~
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R7522 Top A 20 0402R Resistor 5% 63mW 10k ~

R7634 Top E 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7637 Top A 16 0402R
CHIPRES 0W06 1R J
0402 1R ~

R7646 Top E 15 0402R Resistor 5% 63mW 100R ~

R7676 Bot B 16 0805R
CHIPRES 0W125 4R7 J
0805 4R7 ~

R7680 Top C 13 0402R Resistor 5% 63mW 47k ~

R7681 Top C 13 0402R Resistor 5% 63mW 47k ~

R7690 Top B 16 0402R Resistor 5% 63mW 4k7 ~

R7691 Top C 16 0402R Resistor 5% 63mW 4k7 ~

R7692 Top H 5 0402R Resistor 5% 63mW 100R ~

R7699 Bot G 16 0402R Resistor 5% 63mW 100R ~

R7700 Top B 10 0402R Resistor 5% 63mW 1k0 ~

R7701 Top A 10 0402R Resistor 5% 63mW 1k0 ~

R7704 Top I 3 0402R Resistor 5% 63mW 220R ~

R7709 Top B 12 0402R Resistor 5% 63mW 220R ~

R7710 Top A 10 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7711 Top E 15 0402R Resistor 5% 63mW 2k2 ~

R7712 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7714 Top F 15 0402R Resistor 5% 63mW 2k2 ~

R7715 Top E 15 0402R Resistor 5% 63mW 2k2 ~

R7716 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7718 Top F 14 0402R Resistor 5% 63mW 2k2 ~

R7719 Top G 2 0402_VAR
RES VARISTOR 14/90V
3PF 0402 14/90V ~

R7720 Top H 5 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7721 Top I 5 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7722 Top H 3 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7723 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7724 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~
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R7725 Top I 7 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7726 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7732 Bot B 6 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7735 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7736 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7737 Top H 2 0402R Resistor 5% 63mW 100R ~

R7743 Bot B 5 0402R Resistor 5% 63mW 1k0 ~

R7780 Top A 8 0402R Resistor 5% 63mW 47R ~

R9088 Top H 11 0402R Resistor 5% 63mW 4k7 ~

R9089 Top H 11 0402R Resistor 5% 63mW 4k7 ~

R9093 Top F 8 0402R Resistor 5% 63mW 47k ~

R9094 Top D 8 0402R Resistor 5% 63mW 47k ~

R9095 Bot B 18 0402R Resistor 5% 63mW 47R ~

R9100 Top C 11 0402R Resistor 5% 63mW 470k ~

R9101 Top C 11 0402R Resistor 5% 63mW 15k ~

R9102 Top C 11 0402R Resistor 5% 63mW 47R ~

R9103 Top C 11 0402R Resistor 5% 63mW 47R ~

R9104 Top B 11 0402R Resistor 5% 63mW 47R ~

R9111 Top E 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R9112 Top A 10 0402R Resistor 5% 63mW 100k ~

R9113 Top H 14 0402R
Chipres 0W06 jumper
0402 0R ~

R9115 Top G 3 0402R Resistor 5% 63mW 47k ~

R9116 Top G 3 0402R Resistor 5% 63mW 330R ~

R9117 Top F 3 0402R Resistor 5% 63mW 330R ~

R9121 Top B 4 0402R Resistor 5% 63mW 1k0 ~

R9123 Top B 7 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R9125 Bot C 19 0402R
Chipres 0W06 jumper
0402 0R 50V

R9127 Bot C 19 0402R Resistor 5% 63mW 47R ~

R9128 Top F 2 0402R Resistor 5% 63mW 100k ~

R9129 Top F 2 0402R Resistor 5% 63mW 100k ~
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R9130 Top F 3 0402R Resistor 5% 63mW 100k ~

R9131 Top F 2 0402R Resistor 5% 63mW 100k ~

R9132 Top F 3 0402R Resistor 5% 63mW 1k0 ~

R9133 Top G 3 0402R Resistor 5% 63mW 1k0 ~

S4400 Top I 4
SWITCH_EVQQ0C
03K SM SW SPDT 15V 20MA ~ ~

S4401 Bot I 15
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

S4402 Bot I 16
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

S4403 Top I 7
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

T7500 Top H 17 TRANS_LDB15
TRANSF BALUN 2134
+-90MHZ 0805 ~ ~

T7501 Top H 15 TRANS_LDB213
TRANSF BALUN 3800
+-550MHZ 0805 ~ ~

V2000 Bot C 4 BGA4_1.01X1.07 ASIP TVS BGA4 ~ ~

V6500 Bot B 16
DIODE_PMEG300
2

SCH DI 30V IF 0A2 UFSM
3A IR 10UA SOD882 ~ ~

V6501 Top F 21 TRANS_SFH3710

SILICON
PHOTOTRANSISTOR
SF3710 SMT 2.1X1.4X ~ ~

V6504 Top G 21 LED_CL_191
LED BLUE 26MCD 5MA
CL-191S-HB1R ~ ~

V6507 Top H 3 SOT_666
TRX2 EMX1/PEMX1 P
40V 0A1 SOT666 ~ ~

V6509 Top C 12 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

V6511 Top B 15 TUMT6
MOSFET N+P CHANNEL
30V US6M2 ~ ~

V6512 Top C 15 TUMT6
MOSFET N+P CHANNEL
30V US6M2 ~ ~

V6513 Bot B 18 SOD882 BZX884-AA ~ ~

V6514 Top C 13 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

V6515 Top H 6 SOD323F SCH DI 30V 2A SOD323F ~ ~

V6516 Top I 5 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V6518 Bot H 16 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~
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V6519 Top F 15 SOT_666
TRX2 EMX1/PEMX1 P
40V 0A1 SOT666 ~ ~

V6520 Top I 8 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V6521 Top I 3 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V7500 Top G 14 SOT323
TR BC849CW N 30V 0.1A
>420 SOT323 ~ ~

V9102 Bot A 18 SC_75A_H0.95
MOSFET N 20V 350MA
SOT416 ~ ~

V9104 Top G 2 SOT_666
TRX4 4X10K N&P 50V
0A1 0W1 SOT666 ~ ~

W1000 Bot A 3
ANTENNA_NAN68
_PC0400C

ANTENNA INT WLAN
P2636 (3-PAD) ~ ~

X1000 Bot I 3
TRACEABILITY_PA
D

MODULE ID COMPONENT
2.8X1.8X0.3 ~ ~

X2001 Bot E 1
SYSCON_MQ202_
NK_14R3

SM SYSTEM CONNECTOR
14POL ~ ~

X6501 Bot B 17
POGO_CNO_3211_
3125H

CONN POGO PINS
CNO-3211-3125H H4.3 ~ ~

X6507 Top B 9
CON_24R_JANK_P
0.4_H1.75 CONN BTB 2X12F P0.4 ~ ~

X6512 Bot F 15
CONN_CY_5225_1
817H

SM BATTERY CONN
3POLE SPR ~ ~

X6513 Bot D 5
SIM_CONN_2X3P
OL

SM SIM CONN 2X3POL
P2.54 ~ ~

X6515 Top B 11
MOLEX_54722_03
41

SM CONN 2X17F P0.5
PWB/PWB ~ ~

X6522 Top H 12
MOLEX_SD_50091
3_0248

SM CONN 2X12F P0.4
H1.8 PWB/PWB ~ ~

X6523 Top B 16
MOLEX_SD_51338
_0249

SM CONN 2X12F P0.4
PWB/PWB ~ ~

X6526 Bot F 21
SPRING_WN9149
_N10

C-SPRING ANTENNA
active ~ ~

X6527 Bot F 21
SPRING_WN9149
_N10

C-SPRING ANTENNA
active ~ ~

X6530 Bot B 6 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

X6531 Bot A 5 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~
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Z4400 Top B 10
uBGA25_2.47X2.
47

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z6030 Top A 7 EZFVQ42NM61S
LTCC FILT 2441.75
+-41.75MHZ 2.5X2

2441.75M
Hz ~

Z7500 Top H 17
MODULE_SP_LMZ_
137

TX SAW MODULE GSM
850/900MHZ

850/900
MHz ~

Z7540 Top B 20 P_TC3N_12_1_AGI

DUPL BAW
1920-1980/2110-2170
MHZ 3.8X3.8

1920-198
0/2110-2
170MHZ ~

Z7541 Bot C 19 CQF12_N2
RF SWITCH SP3T
850/1800/1900MHZ

880-960/
1710-199
0MHz ~

Z7542 Top C 11
FLIP_CHIP_16_2.0
1X2.02_H0.715

MMC ASP HIGH SPEED
BGA16 ~ ~

Table 11 RM-132 component part list (1TR_11)

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS).

To ensure you are always using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

A7002 Top H 17 SHIELD_0264350
SHIELD RF ASSY
040-021698 ~ ~

A7003 Top B 19 SHIELD_0264351
SHIELD WCDMA ASSY
040-021699 ~ ~

B2200 Top C 5
CRYSTAL_3.3X1.6
_H0.9

CRYSTAL 32.768KHZ
+-30PPM 12.5PF

32.768kH
z ~

C1100 Bot H 15 0402C Chipcap 5% NP0 10p 50V

C1101 Bot H 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2005 Bot F 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2006 Bot F 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2007 Top F 2 0402C Chipcap 5% NP0 10p 50V

C2008 Top F 2 0402C Chipcap 5% NP0 10p 50V

C2009 Top G 2 0402C Chipcap 5% NP0 10p 50V

C2010 Top G 2 0402C Chipcap 5% NP0 10p 50V

C2012 Bot C 4 0603C_H0.95
CHIPCAP X5R 1U K 25V
0603 1u0 25V

C2202 Top C 4 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V
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C2203 Top B 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2204 Top A 4 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2206 Top C 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2210 Bot E 3 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C2211 Top A 5 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2212 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2213 Top C 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2215 Top B 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2217 Top B 4 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C2220 Top A 4 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2222 Top A 5 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2228 Top B 6 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2250 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2251 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2300 Top G 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2304 Top F 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2306 Top G 5 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C2314 Top H 7 0805C
CHIPCAP X5R 4U7 M 25V
0805 4u7 25V

C2316 Top H 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C2317 Top G 5 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V
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C2700 Bot D 5 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2800 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2801 Top F 9 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2802 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2803 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2804 Top G 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2805 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2806 Top H 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C2809 Top F 9 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C3503 Top B 9 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C4201 Top B 14 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3

C4401 Top F 20 0402C Chipcap 5% NP0 27p 50V

C4403 Top C 9 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C4404 Top C 8 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C4405 Top G 11 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C4409 Top I 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C4420 Bot A 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4800 Top E 8 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4801 Top F 9 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4803 Top C 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C4808 Top F 10 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V
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C5002 Top F 6 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C5100 Top C 10 0402C Chipcap 5% NP0 27p 50V

C6031 Top B 7 0402C Chipcap 5% NP0 18p 50V

C6032 Top B 7 0402C Chipcap 5% NP0 100p 50V

C6033 Top B 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6034 Top A 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6035 Top C 6 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6036 Top C 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6037 Top C 7 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6038 Top B 6 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6039 Top A 6 0402C Chipcap 5% NP0 18p 50V

C6051 Top B 7 0402C Chipcap +-0.25pF NP0 2p7 50V

C6052 Top B 7 0402C Chipcap +-0.25pF NP0 2p7 50V

C6055 Top A 7 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6100 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6101 Top A 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6102 Top A 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6103 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6104 Top A 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6105 Top C 2 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6108 Top C 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6109 Top A 2 0402C Chipcap 5% NP0 47p 50V

C6110 Top B 2 0402C Chipcap 5% NP0 27p 50V

C6112 Top B 3 0402C
Chipcap X7R 10% 16V
0402 10n 16V
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C6113 Top A 3 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6502 Bot B 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6503 Bot B 17 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6508 Top E 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6509 Top C 13 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6510 Top B 13 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6515 Top B 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6516 Top C 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6590 Top D 13 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C6592 Top B 14 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C6593 Top C 15 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3

C6594 Top A 16 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C6595 Bot B 17 0805C
CHIPCAP X5R 4U7 M 25V
0805 4u7 25V

C6598 Top I 12 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C7500 Top I 17 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7501 Top G 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7502 Top G 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7504 Top I 17 0402C Chipcap +-0.25pF NP0 2p2 50V

C7505 Top G 14 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C7507 Top I 17 0402C Chipcap +-0.25pF NP0 1p5 50V

C7508 Top H 14 0402C
Chipcap X7R 10% 16V
0402 10n 16V

RM-132; RM-133
Nokia Customer Care Parts Lists and Component Layouts

Page 2 –30 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Item Side Grid ref. Type Description and value

C7509 Top H 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7510 Top G 14 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7511 Top D 14 0805C_H0.95
CHIPCAP X5R 10U M 6V3
T=0.95mm 0805 10u 6V3

C7513 Bot F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7514 Bot F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7515 Top G 19 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7516 Bot C 19 0402C Chipcap +-0.25pF NP0 6p8 50V

C7517 Bot C 19 0402C Chipcap 5% NP0 10p 50V

C7518 Top D 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7519 Bot C 19 0402C Chipcap 5% NP0 27p 50V

C7520 Bot C 19 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7521 Bot C 19 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7523 Top I 14 0402C Chipcap +-0.25pF NP0 3p3 50V

C7525 Bot D 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7526 Top H 14 0603C
CHIPCAP NP0 2N2 G 16V
0603 2n2 16V

C7527 Top H 14 0402C
CHIPCAP NP0 470P J 6V3
0402 470p 6V3

C7528 Bot B 16 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7534 Top D 19 0402C Chipcap 5% NP0 27p 50V

C7537 Bot E 15 0402C Chipcap 5% NP0 10p 50V

C7538 Bot G 16 0402C Chipcap 5% NP0 10p 50V

C7539 Top B 15 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7540 Top I 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7542 Top H 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V
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C7543 Top I 17 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7546 Top C 12 0402C Chipcap 5% NP0 27p 50V

C7547 Top E 13 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C7548 Top F 14 0405_GNM23
CHIP ARRAY X5R 2X1U K
6V3 MA 0405 2x1u 6.3V

C7549 Top F 7 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7550 Top G 7 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7551 Top C 14 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7553 Top I 19 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7563 Top I 15 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7564 Top B 20 0402C Chipcap 5% NP0 27p 50V

C7565 Top A 14 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C7567 Bot D 3 0402C Chipcap 5% NP0 27p 50V

C7568 Top B 3 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C7569 Bot E 5 0402C Chipcap 5% NP0 27p 50V

C7570 Bot D 4 0402C Chipcap 5% NP0 27p 50V

C7571 Bot D 5 0402C Chipcap 5% NP0 27p 50V

C7572 Top B 3 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7573 Top C 4 0402C_H0.6
CHIPCAP X5R 100N M
16V 0402 100n 16V

C7590 Top D 20 0402C Chipcap 5% NP0 27p 50V

C7591 Top F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C7592 Top F 3 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C9059 Top E 15 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C9060 Bot C 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C9070 Top C 13 0402C Chipcap 5% NP0 27p 50V
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C9071 Top A 16 0402C
CHIPCAP X5R 1U K 6V3
0402 1u0 6.3V

C9073 Top C 10 0402C Chipcap 5% NP0 27p 50V

C9074 Top C 16 0402C Chipcap 5% NP0 27p 50V

C9075 Top D 14 0402C Chipcap 5% NP0 27p 50V

C9076 Top H 11 0402C Chipcap 5% NP0 27p 50V

C9077 Top I 12 0402C Chipcap 5% NP0 27p 50V

C9078 Top H 13 0402C Chipcap 5% NP0 27p 50V

C9079 Top F 10 0402C Chipcap 5% NP0 10p 50V

C9080 Top B 4 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C9083 Top H 13 0402C Chipcap 5% NP0 47p 50V

C9084 Bot G 17 0402C Chipcap 5% NP0 56p 50V

C9085 Bot G 16 0402C Chipcap 5% NP0 56p 50V

C9086 Bot H 16 0402C Chipcap 5% NP0 56p 50V

C9087 Top B 16 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C9088 Top G 13 0402C Chipcap 5% NP0 33p 50V

C9090 Top A 13 0402C Chipcap 5% NP0 27p 50V

C9093 Bot C 19 0402C Chipcap +-0.25pF NP0 3p3 50V

D2800 Top H 9 VFBGA343 RAPS V3.01E-PA ~ ~

D5000 Top E 7
FBGA133_11.6X1
3.1

COMBO 512 DDR + 1G
NAND FBGA133 PBFREE

32Mx16/1
28Mx8 ~

D6500 Top D 11 FBGA_195
OMAP DM290
GOLDENEYE NFBGA ~ ~

D6501 Top F 11
WBGA_60_8.1X6.
6_H0.9

SDRAM 4X16 1.8V/1.8V
FBGA60 PBFREE 4Mx16 ~

D6502 Top H 9 FBGA128_EMPTY

COMBO 128M NOR
+128M DDR DRAM
FBGA128

8Mx16/8
Mx16 ~

D6503 Top B 15
uBGA_6_1.45X0.9
5

SN72AUC2G04YZT INV
GATE WCSP06 ~ ~

F2000 Bot C 3
0603_FUSE_AVX2
MATS SM FUSE F 2.0A 32V 2A ~

G1000 Bot B 15 BATTER_EECEP
RTC BACUP CAPAC 311
SIZE FOR 2.6V 4UAH 2.6V ~

G7500 Top G 14 NKG3176B_H1.0
VCTCXO 38.4MHZ 2.5V
2MA 38.4MHz ~
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G7501 Top I 14 VCO_DCS02733
VCO 3296-3980MHZ 4-
BAND MATSUSHITA

3296-398
0MHz ~

J7500 Bot C 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

J7502 Bot C 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

J7590 Bot D 21 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

L2000 Bot C 3 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2002 Bot E 3 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2003 Bot E 2 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2004 Bot E 2 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L2011 Bot G 2 COIL_LK_1608
CHIP COIL 68NH J
Q12/100MHZ 0603 68nH ~

L2302 Top G 8
CHOKE_SER400_H
1.2

INDUCT WW 10UH 0A65
0R35 4X4X1.2 10uH ~

L2309 Top H 6
CHOKE_SER300_H
1.5

CHOKE 22U M 0R7 0.35A
3.0x3.0x1.5 22uH ~

L3002 Bot A 4 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6030 Top B 7 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6031 Top B 7 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H ~

L6032 Top B 6 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L6100 Top B 3 0402LQW
CHIP COIL 47N +-3%
Q25/200MHZ 0402 47nH ~

L6101 Top A 2 0402L_POL2
CHIP COIL 120NH J
Q8/100MHZ 0402 120nH ~

L6500 Top C 14 CHOKE_SER300
INDUCT WW 2.2UH 1A2
310 CASE SIZE 2u2H ~

L6501 Bot B 16
CHOKE_SER300_H
1.5

CHOKE 3U3 1.2A 0R096
3X3X1.5 3u3H ~

L6502 Top E 14 CHOKE_SER300
INDUCT WW 2.2UH 1A2
310 CASE SIZE 2u2H ~
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L6505 Top B 13
CHOKE_SER400_H
1.2

INDUCT WW 10UH 0A65
0R35 4X4X1.2 10uH ~

L6509 Top B 4 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L6517 Top G 3 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6518 Top F 3 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6519 Bot G 16 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6520 Bot G 16 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6521 Top E 3 0405_2_TDK
CHIP BEAD ARRAY
2X220R 0405 2x220R ~

L6522 Bot F 3 0405_2_TDK
CHIP BEAD ARRAY
2X220R 0405 2x220R ~

L6600 Bot C 17 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L6604 Bot B 17 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7500 Top I 16 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7520 Top G 19
FERRITE_FBMJ160
8

FERRITE BEAD 0R01
28R/100MHZ 0603

28R/
100MHz ~

L7542 Bot C 20 0402L
CHIP COIL 12N J
Q31/800M 0402 12nH ~

L7544 Top C 3 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7545 Top G 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7546 Top F 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7547 Bot F 2 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~

L7548 Bot F 20 0402L_XL
CHIP COIL 68N J
Q17/300M 0402 68nH ~

L7549 Bot F 20 0402L_XL
CHIP COIL 68N J
Q17/300M 0402 68nH ~

L7551 Top E 20 0405_2_DLM11G
CHIP BEAD ARRAY
2X600R 0405

2x600R/
100MHz ~
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L7553 Bot B 18 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L7601 Top I 17 0402L
CHIP COIL 8N2 J
Q28/800MHZ 0402 8n2H ~

L7603 Top I 17 0402L
CHIP COIL 18N J
Q29/800M 0402 18nH ~

L7604 Top D 19 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7605 Top D 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7606 Top I 18 0402L
CHIP COIL 2N7+-0N3
Q29/800M 0402 2n7H 50V

L7607 Bot B 5 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L7608 Bot A 5 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L7609 Top I 13 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L7610 Bot F 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L7611 Bot F 20 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L9056 Bot E 6 0402L
CHIP COIL 47N J
Q23/800MHZ 0402 47nH ~

L9057 Top F 10 0402L
CHIP COIL 33N J
Q23/800M 0402 33nH ~

L9060 Top G 13 0603L
CHIP COIL 470N+-2%
Q30/100MHZ 0603 470nH ~

L9097 Bot C 19 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

M1000 Bot B 3
VIBRA_M_KHN4N
X1RA

SMD VIBRA MOTOR 1.3V
80MA 9000RPM ~ ~

N2200 Top B 5 TFBGA_105
AVILMA 1.05C BB
MODULE TFBGA105 ~ ~

N2300 Top G 6 TFBGA64_H1.2 BETTY V2.1 LF TFBGA64 ~ ~

N3500 Top C 9
USMD5_1.47X1.0
4_H0.675

VREG LP3985ITLX-3.0
NOPB USMD5 ~ 3V

N3501 Top C 10 PBGA_N20_P0.5

LEVEL SHIFT
SN74AVCA406LZXYR S-
PBGA-N20 *FOR NRC USE
ONLY* ~ ~
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N4800 Top E 9 uBGA_289
HELEN3 PS2.0 N3
F761909 C27 UBGA289 ~ ~

N6030 Top B 7
CSP_47_3.85X4.0
5 BC4-ROM1.0RDL ~ ~

N6100 Top B 3
WFBGA34_2_3.57
X3.57

FM RECEIVER
TEA5761UK N4B CSP (TI) ~ ~

N6502 Bot A 17 TK11892F

STEP-UP DC/DC CONV
TK11892F-G-20
SON3024-8 ~ ~

N6505 Bot A 16
IRDA_TFBS_GP2W
_CIM IRDA MIR XSMALL ~ ~

N6508 Top E 13
USMD5_1.417X1.
087

DC/DC CONV
LM3671TLX-1.82V
USMD5 ~ ~

N6509 Bot E 3 XBGA_N16
AF AMP TPA2012D2
77DB/217HZ WCSP16 ~ ~

N6513 Top C 14
USMD_8_1.55X1.
55

2XVREG 2.8V/150MA
LP3986 USMD8 PB-FREE ~ 2.8V

N6515 Top B 14
USMD_10_2.458X
1.899

DC/DC CONV
LM3661-1.40V/1.05V
NOPB ~ ~

N6516 Top B 15 ECSP2828_10
SHUTTER DRIVER
LB8681CL ~ ~

N6517 Top B 13
XBGA_N8_2.02X1.
02

DC/DC CONV
TPS6231YZD 1.5V CSP8 ~ ~

N6518 Top E 13
USMD5_1.468X1.
036

REG+ LP3999ITLX 1.8V
150MA NOPB ~ 1.8V

N6519 Top F 14 FC_4_0.99X0.99
LI VREG 1.5V/150MA
WLCSP4 TK63115B ~ 1.5V

N7500 Top H 16 TFBGA_188_H1.4
RF SYSTEM MODULE
PIHI2.22 9.0X9.0X1 ~ ~

N7520 Top H 19 RF9282E3.6

PA RF9282E6.3 GSM/
EDGE
850/900/1800/1900 ~ ~

N7542 Top I 12
USMD5_1.47X1.0
4_H0.675

VREG LP3985ITLX-2.8
NOPB USMD5 ~ 3V

N9002 Top H 7
USMD8_1.69X1.6
9

WHITE LED DRIVER
4LEDS 500MW 8BUMP
USMD8 ~ ~

N9003 Top F 3
uBGA_6_1.45X0.9
5

TI ANALOG SWITCH
TS5A3159AYZTR
WCSP06 ~ ~
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N9004 Top G 3
uBGA_6_1.45X0.9
5

TI ANALOG SWITCH
TS5A3159AYZTR
WCSP06 ~ ~

N9006 Top B 16 FC_4_0.99X0.99
LI VREG 1.5V/150MA
WLCSP4 TK63115B ~ 1.5V

R1100 Bot G 16 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R1101 Bot E 5 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R1102 Bot H 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2006 Top G 2 BGA11
ASIP 4 LINES AUDIO
FILTER BGA11 ~ ~

R2007 Bot E 3
uBGA11_1.6X2.1
5

ASIP SILIC USB OTG / ESD
BGA11 ~ ~

R2009 Top G 5 0402R Resistor 5% 63mW 220k ~

R2303 Top H 7 0402R Resistor 5% 63mW 27R ~

R2800 Top H 8 0402R Resistor 5% 63mW 10R ~

R2801 Top F 10 0402R Resistor 5% 63mW 4k7 ~

R2804 Top G 8 0402R Resistor 5% 63mW 4k7 ~

R2805 Top H 8 0402R Resistor 5% 63mW 4k7 ~

R4400 Bot D 5 0402R Resistor 5% 63mW 470k ~

R4401 Top F 20 0402R Resistor 5% 63mW 100k ~

R4402 Bot D 5 0402R Resistor 5% 63mW 470k ~

R4403 Top F 20 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R4410 Bot C 5 0402R Resistor 5% 63mW 47k ~

R4416 Top B 10 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4420 Bot F 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R4800 Top E 8 0402R Resistor 5% 63mW 10R ~

R4801 Top F 10 0402R Resistor 5% 63mW 1k0 ~

R6030 Top C 7 0402R Resistor 5% 63mW 10k ~

R6031 Top B 6 0402R Resistor 5% 63mW 10k ~

R6032 Top C 7 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R6034 Top B 7 0402R Resistor 5% 63mW 10k ~

R6037 Top A 6 0402R Resistor 5% 63mW 100k ~
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R6100 Top B 3 0402R Resistor 5% 63mW 10k ~

R6101 Top B 3 0402R Resistor 5% 63mW 100k ~

R6102 Top C 3 0402R Resistor 5% 63mW 4k7 ~

R6103 Top C 3 0402R Resistor 5% 63mW 4k7 ~

R6505 Bot A 18 0402R Resistor 5% 63mW 10k ~

R6506 Bot A 17 0402R Resistor 5% 63mW 10k ~

R6507 Bot B 17 0402R
CHIPRES 0W06 3R3 J
0402 3R3 ~

R6508 Bot A 17 0402R
CHIPRES 0W06 3R3 J
0402 3R3 ~

R6510 Top E 12 0402R Resistor 5% 63mW 100R ~

R6512 Top D 12 0402R Resistor 5% 63mW 100R ~

R6513 Top E 12 0402R Resistor 5% 63mW 2k2 ~

R6516 Top G 11 0402R Resistor 5% 63mW 100R ~

R6517 Top D 12 0402R Resistor 5% 63mW 100R ~

R6519 Top D 13 0402R Resistor 5% 63mW 10R ~

R6520 Top B 13 0402R Resistor 5% 63mW 10R ~

R6590 Top D 12 0402R Resistor 5% 63mW 100R ~

R6599 Top C 12 0402R Resistor 5% 63mW 100R ~

R7000 Top F 14 0402R Resistor 5% 63mW 47R ~

R7501 Top H 15 0402R Resistor 5% 63mW 22k ~

R7502 Top H 13 0402R Resistor 5% 63mW 330R ~

R7504 Top I 17 0402R Resistor 5% 63mW 4k7 ~

R7505 Top H 13 0402R Resistor 5% 63mW 27k ~

R7507 Top G 13 0402R
CHIPRES 0W06 1K5 F
100PPM 0402 1k5 ~

R7509 Top G 18 0402R Resistor 5% 63mW 27k ~

R7515 Top I 15 0402R
Chipres 0W06 5R6 J
0402 5R6 ~

R7516 Top H 14 0402R
CHIPRES 0W06 8K2 F
0402 8k2 ~

R7517 Top H 14 0402R
CHIPRES 0W06 1K0 F
200PPM 0402 1k0 ~

R7541 Top B 20 0402R Resistor 5% 63mW 47R ~

R7634 Top E 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~
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Item Side Grid ref. Type Description and value

R7637 Top A 16 0402R
CHIPRES 0W06 1R J
0402 1R ~

R7646 Top E 15 0402R Resistor 5% 63mW 100R ~

R7676 Bot B 16 0805R
CHIPRES 0W125 4R7 J
0805 4R7 ~

R7680 Top C 13 0402R Resistor 5% 63mW 47k ~

R7681 Top C 13 0402R Resistor 5% 63mW 47k ~

R7690 Top B 16 0402R Resistor 5% 63mW 4k7 ~

R7691 Top C 16 0402R Resistor 5% 63mW 4k7 ~

R7692 Top H 5 0402R Resistor 5% 63mW 100R ~

R7699 Bot G 16 0402R Resistor 5% 63mW 100R ~

R7700 Top B 10 0402R Resistor 5% 63mW 1k0 ~

R7701 Top A 10 0402R Resistor 5% 63mW 1k0 ~

R7704 Top I 3 0402R Resistor 5% 63mW 220R ~

R7709 Top B 12 0402R Resistor 5% 63mW 220R ~

R7710 Top A 10 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7711 Top E 15 0402R Resistor 5% 63mW 2k2 ~

R7712 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7714 Top F 15 0402R Resistor 5% 63mW 2k2 ~

R7715 Top E 15 0402R Resistor 5% 63mW 2k2 ~

R7716 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7718 Top F 14 0402R Resistor 5% 63mW 2k2 ~

R7719 Top G 2 0402_VAR
RES VARISTOR 14/90V
3PF 0402 14/90V ~

R7720 Top H 5 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7721 Top I 5 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7722 Top H 3 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7723 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7724 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7725 Top I 7 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~
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Item Side Grid ref. Type Description and value

R7726 Bot I 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7732 Bot B 6 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R7735 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7736 Top I 2 0402R Resistor 5% 63mW 2k2 ~

R7737 Top H 2 0402R Resistor 5% 63mW 100R ~

R7743 Bot B 5 0402R Resistor 5% 63mW 1k0 ~

R7780 Top A 8 0402R Resistor 5% 63mW 47R ~

R9088 Top H 11 0402R Resistor 5% 63mW 4k7 ~

R9089 Top H 11 0402R Resistor 5% 63mW 4k7 ~

R9093 Top F 8 0402R Resistor 5% 63mW 47k ~

R9094 Top D 8 0402R Resistor 5% 63mW 47k ~

R9095 Bot B 18 0402R Resistor 5% 63mW 47R ~

R9100 Top C 11 0402R Resistor 5% 63mW 470k ~

R9101 Top C 11 0402R Resistor 5% 63mW 15k ~

R9102 Top C 11 0402R Resistor 5% 63mW 47R ~

R9103 Top C 11 0402R Resistor 5% 63mW 47R ~

R9104 Top B 11 0402R Resistor 5% 63mW 47R ~

R9111 Top E 20 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R9112 Top A 10 0402R Resistor 5% 63mW 100k ~

R9113 Top H 14 0402R
Chipres 0W06 jumper
0402 0R ~

R9115 Top G 3 0402R Resistor 5% 63mW 47k ~

R9116 Top G 3 0402R Resistor 5% 63mW 330R ~

R9117 Top F 3 0402R Resistor 5% 63mW 330R ~

R9121 Top B 4 0402R Resistor 5% 63mW 1k0 ~

R9123 Top B 7 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R9125 Bot C 19 0402R
Chipres 0W06 jumper
0402 0R 50V

R9127 Bot C 19 0402R Resistor 5% 63mW 47R ~

R9128 Top F 2 0402R Resistor 5% 63mW 100k ~

R9129 Top F 2 0402R Resistor 5% 63mW 100k ~

R9130 Top F 3 0402R Resistor 5% 63mW 100k ~

R9131 Top F 2 0402R Resistor 5% 63mW 100k ~
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Item Side Grid ref. Type Description and value

R9132 Top F 3 0402R Resistor 5% 63mW 1k0 ~

R9133 Top G 3 0402R Resistor 5% 63mW 1k0 ~

S4400 Top I 4
SWITCH_EVQQ0C
03K SM SW SPDT 15V 20MA ~ ~

S4401 Bot I 15
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

S4402 Bot I 16
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

S4403 Top I 7
SWITCH_EVQP7J0
1C

SWITCH TACT SPST 12V
SIDE KEY 1.6N ~ ~

T7501 Top H 15 TRANS_LDB213
TRANSF BALUN 3800
+-550MHZ 0805 ~ ~

V2000 Bot C 4 BGA4_1.01X1.07 ASIP TVS BGA4 ~ ~

V6500 Bot B 16
DIODE_PMEG300
2

SCH DI 30V IF 0A2 UFSM
3A IR 10UA SOD882 ~ ~

V6501 Top F 21 TRANS_SFH3710

SILICON
PHOTOTRANSISTOR
SF3710 SMT 2.1X1.4X ~ ~

V6504 Top G 21 LED_CL_191
LED BLUE 26MCD 5MA
CL-191S-HB1R ~ ~

V6507 Top H 3 SOT_666
TRX2 EMX1/PEMX1 P
40V 0A1 SOT666 ~ ~

V6509 Top C 12 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

V6511 Top B 15 TUMT6
MOSFET N+P CHANNEL
30V US6M2 ~ ~

V6512 Top C 15 TUMT6
MOSFET N+P CHANNEL
30V US6M2 ~ ~

V6513 Bot B 18 SOD882 BZX884-AA ~ ~

V6514 Top C 13 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

V6515 Top H 6 SOD323F SCH DI 30V 2A SOD323F ~ ~

V6516 Top I 5 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V6518 Bot H 16 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V6519 Top F 15 SOT_666
TRX2 EMX1/PEMX1 P
40V 0A1 SOT666 ~ ~

V6520 Top I 8 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~
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Item Side Grid ref. Type Description and value

V6521 Top I 3 LED_CL_270
LED BLUE 26MCD 5MA
0603 ~ ~

V7500 Top G 14 SOT323
TR BC849CW N 30V 0.1A
>420 SOT323 ~ ~

V9102 Bot A 18 SC_75A_H0.95
MOSFET N 20V 350MA
SOT416 ~ ~

V9104 Top G 2 SOT_666
TRX4 4X10K N&P 50V
0A1 0W1 SOT666 ~ ~

W1000 Bot A 3
ANTENNA_NAN68
_PC0400C

ANTENNA INT WLAN
P2636 (3-PAD) ~ ~

X1000 Bot I 3
TRACEABILITY_PA
D

MODULE ID COMPONENT
2.8X1.8X0.3 ~ ~

X2001 Bot E 1
SYSCON_MQ202_
NK_14R3

SM SYSTEM CONNECTOR
14POL ~ ~

X6501 Bot B 17
POGO_CNO_3211_
3125H

CONN POGO PINS
CNO-3211-3125H H4.3 ~ ~

X6507 Top B 9
CON_24R_JANK_P
0.4_H1.75 CONN BTB 2X12F P0.4 ~ ~

X6512 Bot F 15
CONN_CY_5225_1
817H

SM BATTERY CONN
3POLE SPR ~ ~

X6513 Bot D 5
SIM_CONN_2X3P
OL

SM SIM CONN 2X3POL
P2.54 ~ ~

X6515 Top B 11
MOLEX_54722_03
41

SM CONN 2X17F P0.5
PWB/PWB ~ ~

X6522 Top H 12
MOLEX_SD_50091
3_0248

SM CONN 2X12F P0.4
H1.8 PWB/PWB ~ ~

X6523 Top B 16
MOLEX_SD_51338
_0249

SM CONN 2X12F P0.4
PWB/PWB ~ ~

X6526 Bot F 21
SPRING_WN9149
_N10

C-SPRING ANTENNA
active ~ ~

X6527 Bot F 21
SPRING_WN9149
_N10

C-SPRING ANTENNA
active ~ ~

X6530 Bot B 6 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

X6531 Bot A 5 SMK_T_314849D
SM CONN ANTENNA
SPACER PAD ~ ~

Z4400 Top B 10
uBGA25_2.47X2.
47

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z6030 Top A 7 EZFVQ42NM61S
LTCC FILT 2441.75
+-41.75MHZ 2.5X2

2441.75M
Hz ~
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Item Side Grid ref. Type Description and value

Z7500 Top H 17
MODULE_SP_LMZ_
137

TX SAW MODULE GSM
850/900MHZ

850/900
MHz ~

Z7541 Bot C 19 CQF12_N2
RF SWITCH SP3T
850/1800/1900MHZ

880-960/
1710-199
0MHz ~

Z7542 Top C 11
FLIP_CHIP_16_2.0
1X2.02_H0.715

MMC ASP HIGH SPEED
BGA16 ~ ~
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Component layouts

RM-133 component layouts

Figure 2 RM-133 component layout - bottom (1SU_11)
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Figure 3 RM-133 component layout - top (1SU_11)
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RM-132 component layouts

Figure 4 RM-132 component layout - bottom (1TR_11)
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Figure 5 RM-132 component layout - top (1TR_11)
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 Phoenix installation steps in brief

Prerequisites
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PKD-1 (DK2) dongle

• DKU-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a PKD-1 (DK2) dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

• Update FPS-10 software

Note: There is no need to activate FPS-10.

• Activate SX-4 smart card, if you need tuning and testing functions.

Note: When FPS-10 is used only for product software updates, SX-4 smart card is not needed.

RM-132; RM-133
Phoenix Service Software Instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 3 –5
Copyright © 2006 Nokia. All rights reserved.



Results
Phoenix is ready to be used with FPS-10 flash prommer and other service tools.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 6 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer text carefully and click Yes.

Figure 7 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 8 InstallShield Wizard Complete

Next actions
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-10 flash prommer can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55
to a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can
choose between a total uninstallation or a repair installation in a similar way when choosing to uninstall
the application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 9 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 10 Remove program

The progress of the uninstallation is shown.

3. If the operating system does not require rebooting, click Finish to complete.

Figure 11 Finish uninstallation
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If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .

3. In the following view, select Repair.

Figure 12 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files

RM-132; RM-133
Phoenix Service Software Instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 3 –11
Copyright © 2006 Nokia. All rights reserved.



• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Prerequisites
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.

• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.
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2. Click Next.

3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 13 Data package setup information

4. To continue, click Next.
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5. Choose the destination folder, and click Next to continue.

Figure 14 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.
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Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 15 InstallShield Wizard Complete

Next actions
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-8 and FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in
the readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 16 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 17 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 18 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 19 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from
the Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 20 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For a plain USB connection, choose the following connection settings:

Note: First connect the DKU-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.
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6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 21 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 22 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 23 Product support module information (example from RM-1)

 Installing flash support files for FPS-8 and FPS-10

Prerequisites
• Install Phoenix service software.

• Install phone model specific data package for Phoenix.

• If you want to update the flash support files, they are delivered in the same installation package with
Phoenix or newer Phoenix packages beginning from December 2004.

In case you want to update the MCU files, install the latest data package (see Technical Bulletins for
information on the latest one).

Normally, it is enough to install Phoenix and the phone-specific data package because the installation
always includes the latest flash update package files for FPS-8 and FPS-10.

• A separate installation package for flash support files is available. The files can be updated according to
these instructions, if updates appear between Phoenix data package releases.

Context
If you are not using a separate installation package, you can skip this section and continue with  "Updating
FPS-8 and FPS-10 flash prommer software" (page 3–22) after installing a new phone data package.
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Steps
1. To begin the installation, double-click the flash update file (for example,

flash_update_03_183_0014.exe).

Figure 24 Flash update welcome dialog

If the same version of the flash update package already exists, and you want to reinstall it, the previous
package is first uninstalled.

Restart installation again after the uninstallation.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If there is a need to
downgrade the version, uninstall newer files manually from the Windows Control Panel, and then rerun
the installation.

Figure 25 Flash installation interrupted

If an older version exists on your PC and it needs to be updated, click Next to continue installation.
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3. It is recommended to install the files to the default destination folder C:\Program Files\Nokia\Phoenix.
To continue, click Next.

Figure 26 Flash destination folder

When installing the flash update files for the first time, you may choose another location by selecting
Browse (not recommended).
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4. To complete the installation procedure, click Finish .

Figure 27 Finish flash update

Next actions
FPS-8 and FPS-10 flash prommers must be updated using Phoenix.

 Updating FPS-8 and FPS-10 flash prommer software

Steps
1. Start Phoenix service software, and log in.

2. Choose the correct connection for your flash prommer: File→Manage Connections...

3. Choose Flashing→Prommer maintenance .

4. To update the FPS-8/FPS-10 software, click Update, and select the appropriate file fps8upd.ini (for FPS-8)
or fpsxupd.ini (for FPS-10) from C:\Program Files\Nokia\Phoenix\Flash.

Figure 28 Flash directory window
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Tip: All files can be loaded separately to the prommer used. To do this, click the right mouse button
in the Flash Box Files pane and select the file type(s) to be loaded.

5. Click OK.

Figure 29 Prommer software update finished

6. To close the Prommer Maintenance window, click Close.

Figure 30 Prommer Maintenance window

 Activating FPS-8

Context
Before FPS-8 can be successfully used for phone programming, it must first be activated.

First fill in the FPS-8 activation request sheet in the FPS-8 sales package, and follow the instructions given.

When activation file is received (for example, 00000.in), copy it to the C:\ProgramFiles\Nokia\Phoenix
\BoxActivation directory on your computer (this directory is created when Phoenix is installed).
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Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Activate.

4. To find the activation file, click Browse.

5. To activate the prommer, select the activation file and click Open.

Figure 31 Box activation

6. To complete the activation, restart FPS-8.

 Deactivating FPS-8

Context
If there is, for example, a need to send the FPS-8 box for repair, it must be deactivated first.

Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Deactivate.

4. To confirm the deactivation, click Yes.

Figure 32 Deactivation warning
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The box is deactivated.

5. To complete the deactivation, restart FPS-8.
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 New service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-132; RM-133, refer to various concepts.

FS-19 Flash adapter

Flash adapter FS-19 is used for phone testing and flashing.

FS-19 is used with the generic flash adapter base SS-60/62 and control
Unit CU-4 or interface adapter SS-46. When flashing or system testing
the phone, the adapter is attached to replace the phone's own battery.

All functions (as well as the calibration voltages, current and the
protections for over voltages, over current and voltage polarity), are
performed by CU-4.

Flash adapter FS-19 main features:

• VBATT supply interface

• USB / FBUS multiplexed interface to the phone

• Supply voltage for light source

MJ-87 Module jig

The MJ-87 module jig is used for testing the following modules:

• User interface

• Baseband and RF on system module

Note: The nominal supply voltage for MJ-87 is +6.0 V. The
supply voltage must not exceed +12.0 V (min. 5.0 V).

Supply the power to the jig only when the jumper is open =
regulated.

RF attenuations:

• Table 12 Attenuation values

Band Attenuation

GSM850 0.15 dB ± 0.05

GSM900 0.17 dB ± 0.05

GSM1800 0.36 dB ± 0.1

GSM1900 0.46 dB ± 0.1

WCDMA2100 0.71 dB ± 0.2
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SA-112 RF coupler

SA-112 is an RF coupler for WCDMA and GSM RF testing. It is used
together with the product-specific flash adapter.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-112:

• Band Channel Attenuation Rx Attenuation Tx

GSM 850

Low 128 11.8 14.2

Mid 189 11.1 13.6

High 251 10 12.9

GSM 900

Low 975 8.9 11.1

Mid 62 8.7 9.8

High 124 8.8 9.2

GSM
1800

Low 513 19.6 24

Mid 700 17.9 21.3

High 884 16.2 20.7

GSM
1900

Low 513 14.2 17.9

Mid 661 13.3 16.2

High 809 13 14.9

WCDMA
Band I

Low 16.1 21.3

Mid 15.7 21.6

High 15.5 22.2

 Common service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-132; RM-133, refer to various concepts.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.
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CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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DKU-2 USB connectivity
cable

USB to system connector cable.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable
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PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled operating voltage.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

RJ-114 Rework jig

RJ-114 is a rework jig used with ST-41.

RJ-57 Rework jig

RJ-57 is a rework jig used with ST-22.
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RJ-71 Rework jig

RJ-71 is a rework jig used with ST-26 rework stencil.

RJ-73 Rework jig

RJ-75 Soldering jig

RJ-75 is a soldering jig used for soldering and as a rework jig for the
engine module.

SB-6 Bluetooth tester

The SB-6 test box is a generic device to perform Bluetooth bit error
rate testing and doing cordless FBUS connection via Bluetooth.

SPS-2 Soldering paste
spreader
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SRT-6 Opening tool

SRT-6 is used to open phone covers and B-to-B connectors.

SS-45 Front camera
removal tool

The front camera removal tool SS-45 is used to remove/attach the
front camera module from/to the socket.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-51 Front camera
removal tool

The front camera removal tool SS-51 is used to remove/attach a front
camera module from/to the camera socket of the phone PWB.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB
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SS-93 Opening tool

SS-93 is used for opening JAE connectors.

ST-20 Rework stencil

ST-20 is used with RJ-73 rework jig.

ST-26 Rework stencil

ST-26 is a rework stencil used with rework jig RJ-71.

ST-36 Rework stencil

ST-36 is a rework stencil used with rework jig RJ-103.

ST-41 Rework stencil

ST-41 is a rework stencil used with rework jig RJ-114.

ST-44 Rework stencil

ST-44 is a rework stencil used with rework jig RJ-57.
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SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

XCS-1 Service cable

The XCS-1 service cable is used to connect FLS-4S to the POS flash
adapter for supplying a controlled operating voltage and data
connection.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB
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 Service concepts

MJ-87 module jig concept

Item Type Description

1 MJ-87 Module jig

2 CU-4 Control unit

3 FPS-10 Flash prommer box

4 SX-4 Smart card

5 XCS-4 Modular cable

6 PCS-1 DC power cable

7 Standard USB cable

8 Standard USB cable

9 GPIB control cable

10 XRS-6 RF cable

11 PKD-1 SW security device

12 RF shield box

Note: Item 12 not shown in the picture.
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Service concept for RF/BB testing and tuning

Item Type Description

1 MJ-87 Module jig

2 CU-4 Control unit

3 Standard USB cable

4 PCS-1 DC power cable

5 Standard USB cable + smart card
reader

6 SX-4 Smart card

7 XRS-6 RF cable

8 GPIB control cable

9 PKD-1 SW security device

10 RF shield box

Note: Item 10 not shown in the picture.
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POS flash concept

Item Type Description

1 RM-133/132 with BP-6MS Transceiver with a battery

2 CA-53 USB connectivity cable

3 FLS-4S POS flash device

4 ACF-8 Charger

RM-132; RM-133
Service Tools and Service Concepts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 4 –17
Copyright © 2006 Nokia. All rights reserved.



Flash concept with FPS-10 and LAN

Item Type Description

1 FS-19 Flash adapter

2 SS-46 Interface adapter

3 CA-35S Power cable

4 XCS-4 Modular cable

5 FPS-10 Flash prommer

6 Standard USB cable

7 PKD-1 SW security device
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CU-4 flash concept with FPS-10

Item Type Description

1 FS-19 + SS-62 Flash adapter + generic flash
adapter base for BB5 products

2 CU-4 Control unit

3 XCS-4 Modular cable

4 PCS-1 Power cable

5 FPS-10 Flash prommer

6 Standard USB cable

7 Standard USB cable

8 PKD-1 SW security device
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RF testing and BB testing/tuning

Item Type Description

1 FS-19 + SS-62 Flash adapter + generic flash
adapter base for BB5 products

2 CU-4 Control unit

3 SA-112 RF coupler

4 PCS-1 Power cable

5 Standard USB cable

6 Standard USB cable

7 SX-4 Smart card

8 GBIP control cable

9 XRS-6 RF cable

10 PKD-1 SW security device

11 RF shield box

Note: Item 11 not shown in the picture.
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 Disassembly instructions

Prerequisites

Figure 33 Needed tools: a Torx Plus size 6 screwdriver, metal tweezers, a DC plug, the SS-93 opening tool, a dental pick and
the SRT-6.

Steps
1. Cover the window with a protective film.
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2. Unlock and open the SLIDE COVER ASSEMBLY.

3. Cover the CAMERA WINDOW with a protective film.

4. Place the SS-93 between the KEYMAT and the edge of the A-COVER and unlock the button clip first.
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5. Hold the SS-93 in the shown position and unlock the side clip with SRT-6 by pressing it between the A-
COVER and the B-COVER.

6. Do the same on the other side.

7. Slide the SRT-6 along the marked edges to unlock the snaps.
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8. Do the same on the other side.

9. Lift the A-COVER a bit and unlock its top side from the BCOVER with the SS-93.

10. Remember to protect the inner side of the window with a protective film.
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11. Unlock and remove the KEYMAT.

12. Carefully unlock and remove the DISPLAY SHIELD by using the dental tool.

13. Cover the DISPLAY with a protective film.

RM-132; RM-133
Disassembly/reassembly instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 5 –9
Copyright © 2006 Nokia. All rights reserved.



14. Gently lift out the DISPLAY with the SS-93 from the UI FRAME…

15. …and disconnect it from the ENGINE MODULE.

16. Open the FRONT CAMERA connector.
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17. Remove the FRONT CAMERA from the UI-FRAME.

18. The CAMERA BOOT can now be separated from the FRONT CAMERA.

19. Carefully open the UI MODULE connector taking special care to the surrounding components.
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20. Undo the screws in the order shown.

21. Remove the screws and discard them.

22. The UI FRAME is attached with two snaps to the B-COVER.
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23. Unlock the UI FRAME with the SS-93.

24. Open the SD DOOR but do not remove it yet.

25. Lift the UI FRAME a bit and unsnap the LIGHT GUIDE.
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26. Now remove the SD DOOR.

27. Remove the UI FRAME with the UI MODULE from the B-COVER.

28. Take special care to the BASEBAND GASKET.
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29. Open the snap if it snapped back and remove the LIGHT GUIDE.

30. Place the UI MODULE over the JOYSTICK HAT and carefully lever out the MODULE from the UI FRAME with
SS-93.
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31. Move the UI MODULE to the primary position and then remove the UI MODULE by using the SS-93 as a
support.

32. Gently, unlock the BASEBAND GASKET as shown and remove it from the UI FRAME.
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33. Replace the EARPIECE when necessary. Keep in mind to remove the EARPIECE ADHESIVE residues before
assembling a new EARPIECE with a new EARPIECE ADHESIVE.

34. Disconnect the MAIN CAMERA from the ENGINE MODULE and remove it carefully from its housing.

35. The ENGINE MODULE is snapped to the B-COVER with two snaps.
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36. Unlock the ENGINE MODULE with the SS-93 and remove it as shown taking care to all spring contacts.

37. Unlock the ANTENNA MODULE ASSEMBLY with the SS-93...

38. ...and remove it from the B-COVER.
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39. Lift the IHF SPEAKER from its housing and remove it easily.

40. Gently push down the FLASH LED from the ANTENNA MOULDING.

41. Remove the GASKET IHF HOUSING.
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42. Remove the IHF SPEAKER 2 remember to remove whole IHF GASKET 2 residues.

43. Remove the MICROPHONE with the dental pick.

44. Use the DC plug to release the DC-JACK.

RM-132; RM-133
Nokia Customer Care Disassembly/reassembly instructions

Page 5 –20 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



45. The DC-JACK drops out easily when turning the B-COVER.

The disassembly procedure is now finished.
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 Reassembly instructions

Prerequisites

Figure 34 Needed tools: a Torque driver, a Torx size 6 plus bit, metal tweezers and the SS-93 opening tool.

Steps
1. Insert the MICROPHONE exactly as shown, avoid bending the spring contacts.
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2. Take a special attention to the right position of the spring contacts

3. to avoid short-circuit or malfunction of the MICROPHONE..

4. Place the DC-JACK with tweezers into its housing ...
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5. and push it carefully into place with the SS-93. Do not bend the spring contacts.

6. Ensure the correct position of the new IHF GASKET 2.

7. Place the IHF SPEAKER 2 into the B-COVER and press it lightly to stick it on correctly.
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8. Position the GASKET IHF HOUSING onto its place paying attention to the spring contacts of the IHF SPEAKER.

9. Place the FLASH LED into its socket and secure it carefully with the SS-93.

10. Insert the ANTENNA MOULDING in the B-COVER...
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11. ...and press it lightly into place.

12. Insert the IHF SPEAKER paying attention to its spring contacts.

13. Insert the ENGINE MODULE under the shown angle.
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14. Pay special attention to the SWITCHES when inserting the ENGINE MODULE into the B-COVER.

15. Secure the ENGINE MODULE.

16. Clean the camera window.
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17. and the MAIN CAMERA with compressed air.

18. Insert the MAIN CAMERA into its housing...

19. ...and carefully close the connector.
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20. Place the BASEBAND GASKET on the IU FRAME and secure it as shown.

21. Place the EARPIECE with a new EARPIECE ADHESIVE into its frame, avoid bending the spring contacts.

22. Ensure the correct position of the CAMERA BOOT when putting it onto the FRONT CAMERA.
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23. Fit the FRONT CAMERA to the UI-FRAME.

24. Position the UI MODULE onto the UI FRAME and slightly press on the JOYSTICK HAT to ensure that it is
glued.

25. Check the right positioning of the UI MODULE.
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26. Place the LIGHT GUIDE over the UI MODULE and carefully fit it to the UI FRAME.

27. Put the UI FRAME into the B-COVER and press it into place.

28. Gently, close the connectors.
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29. Use always new screws when assembling the unit.

30. Set the torque driver to the torque of 28 Newton centimeter.

31. To avoid damaging the plastic threads, first turn the screws slightly left to engage the thread and then
tighten them lightly.
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32. Tighten the screws to the correct torque in the order shown.

33. Connect the DISPLAY to the ENGINE MODULE...

34. ...and place it carefully onto the UI FRAME.
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35. After removal of the plastic film check the surface of the DISPLAY for cleanliness.

36. Fit the DISPLAY SHIELD to the UI FRAME.

37. Insert the SD DOOR but do not close it yet.
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38. Put the KEYMAT into the A-COVER.

39. Check the window for cleanliness.

40. And fit the A-COVER to the B-COVER.
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41. Now, close the SD DOOR.

42. Fit the SLIDE COVER ASSEMBLY

43. Finally, check the functionality of the keys and ensure that there are no gaps between the covers.
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 Baseband troubleshooting

Context
This section is intended to be a guide for localising and repairing electrical faults. The fault repairing is divided
into troubleshooting paths. The following main troubleshooting tree describes the different baseband
troubleshooting paths to be followed in fault situations.
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Troubleshooting flow
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking troubleshooting - CMT

Troubleshooting flow
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 General power checking troubleshooting - application processor

Troubleshooting flow
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 CMT clocking troubleshooting

Troubleshooting flow
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 Application processor troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 Battery current measuring fault troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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Figure 35 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.

Figure 36 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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 CMT SDRAM memory troubleshooting

Troubleshooting flow
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 CMT NOR flash fault troubleshooting

Troubleshooting flow
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 Application processor memory troubleshooting

Troubleshooting flow
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 Power key troubleshooting

Troubleshooting flow

RM-132; RM-133
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –22 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



 USB interface troubleshooting

Troubleshooting flow
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Figure 37 USB 1: D-TXD (system connector pin6) and D+RXD (system connector pin7) voltage levels when USB connected.
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 SIM card troubleshooting

Troubleshooting flow
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SIM CLK frequency = 3.2MHz (Take single triggered measurement in boot on the VSIM1 line).
Figure 38 SIM interface signals
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 SD card troubleshooting

Troubleshooting flow
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Figure 39 SD clk cdm diagram

Figure 40 SD data 0_1 diagram

Figure 41 SD data 2_3 diagram
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 IrDA troubleshooting

Troubleshooting flow

RM-132; RM-133
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –30 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Figure 42 IR TX diagram

Figure 43 IR RX diagram
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 Display controller troubleshooting

Troubleshooting flow

 Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, corrosion).
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• Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see
section Keyboard.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow
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 Slider switch troubleshooting

Troubleshooting flow
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 Certificate restoring for BB5.0 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

Note: USB flashing does not work for a dead BB5.0 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5.0 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart card
reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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 Display module troubleshooting

General instructions for display troubleshooting
The first step is to verify with a working display that the fault is not on the display module itself. The display
module cannot be repaired.

The second step is to check that the cellular engine is working normally. This can be done by connecting the
phone to a docking station and starting Phoenix service software. With the help of Phoenix read the phone
information to check that also application engine is functioning normally (you should be able to read the
APE ID).

After these checks proceed to the display troubleshooting flowcharts. Use the Display Test tool in Phoenix to
find the detailed fault mode.

Operating modes of the display
Display is in a normal mode when the phone is in active use.

Display is in a partial idle mode when the phone is in the screen saver mode.

Display is in OFF mode when the phone is in the full idle mode (idle LED is flashing).

The operating modes of the display can be controlled with the help of Phoenix.

Table 13 Display module troubleshooting cases

Display blank There is no image on the display and Idle LED does
not flash. Display looks the same when the phone is
on as it does when the phone is off. The backlight
can be on in some cases.

Image on the display not correct Image on the display can be corrupted or part of the
image can be missing. If part of image is missing
change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone. Backlight is also
controlled automatically by the ambient light
sensor.

This means that in case the display is working
(image OK) but the backlight is not, follow the
Display and keyboard backlight troubleshooting..

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the table below.

RM-132; RM-133
BB Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –41
Copyright © 2006 Nokia. All rights reserved.



Table 14 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White
Dot
Total

1 1

1 1 1 1

2 Combine
d defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should
be interpreted as combined dot defect.

Note: Blinking pixels are not allowed in normal operating temperatures and light conditions.
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Display fault troubleshooting

Troubleshooting flow
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Display and keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for both display and keyboard backlights.

Keyboard backlights are turned ON only in dark conditions. This is controlled by the Ambient Light Sensor
(ALS). Also the brightness of the display is adjusted by the ambient light sensor.

You can enable/disable ALS with the help of Phoenix service software.

Display brightness can be adjusted manually, if ALS is disabled. If the ambient light sensor is enabled, it
adjusts the display brightness automatically.

Troubleshooting flow

ALS troubleshooting

Context
• If a phototransistor is broken, replace it with a typical phototransistor.

• If the phototransistor is changed, the calibration value in the phone memory has to be changed to the
default value ‘1’.
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• Make sure that you have completed Display and keypad backlight troubleshooting first before starting ALS
troubleshooting.

Here are some hints for ALS troubleshooting; the following troubleshooting diagram refers to these:

• Phoenix LED control tool also shows you luminance. The correct luminance in darkness is <20lx, and in
office environment 100-2000lx. The luminance value depends strongly on the light source and the angle
of the phone, so these values are only a rough guideline.

• LED driver control voltage measurement points can be found from LED driver troubleshooting section.
When backlight brightness is set to 100%, both GENOUT-signals are low, and enable PWM is 100%.

• Phoenix has an ambient light sensor calibration tool for changing calibration values. The pull-up resistor
calibration is done first:

a Cover the light guide (upper part of the A Cover).

b Click Start Write .

c Manually change the ambient light sensor value to the default value. There is no special tool for this,
but you have to perform calibration normally and then set the Co-efficient result to 1 before writing
it to the phone memory.

Figure 44 Ambient Light Sensor Calibration window
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Troubleshooting flow
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LED driver troubleshooting

Troubleshooting flow
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 Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the BT antenna to become loose or partially
detached from the PWB. (see next page for details
about BT antenna HW and Mechanics)

A malfunction in the BT ASIC, BB ASICs or Phone’s BT
SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Location of the BT antenna
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Bluetooth component layout

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.
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Figure 45 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 46 Bluetooth self tests in Phoenix
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Bluetooth BER failure troubleshooting

Troubleshooting flow
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BT audio failure troubleshooting

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Current probe (Internal handsfree DPMA output measurement)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.
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Loop test Input terminal Output
terminal

Path
gain
[dB]

(fixed)

Input
volta

ge
[mVp-

p]

Differen
tial

output
voltage
[mVp-p]

Outpu
t DC

level
[V]

Outp
ut

curre
nt

[mA]

External Mic to External
Earpiece

XMICP and GND HSEAR R P,
HSEAR R N
and GND

-2.9 1000 720 1.2 NA

HSEAR P,
HSEAR N and
GND

XMICN and GND HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND

External Mic to Internal
Earpiece

XMICP and GND EarP and GND -4.5 1000 600 1.2 NA

EarN and
GND

XMICN and GND EarP and GND

EarN and
GND

External Mic to Internal
handsfree

XMICP and GND X2102 pads

B2103 pads

-5 1000 560 0 25m
A
(calc
.)XMICN and GND X2001 pads

B2103 pads

Internal Mic to External
Earpiece

B2202 (OUT/
GND)

HSEAR R P,
HSEAR R N
and GND

22.7 100 1360 1.2 NA

HSEAR P,
HSEAR N and
GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND
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Measurement data

Figure 47 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 48 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 49 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 15 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to RF troubleshooting
All measurements should be done using:

• spectrum analyser with a low-impedance wideband passive probe (LO-/reference frequencies and RF
power levels).

Note: When measuring frequencies of 4GHz, absolute level measurements are not possible with
this probe. Compare levels with a known good board.

• oscilloscope with a 10:1 probe (DC-voltages and low frequency signals)

Caution: A mobile phone WCDMA transmitter should never be tested with full Tx power, if there is
no possibility to perform the measurements in a good performance RF-shielded room. Even low
power WCDMA transmitters may disturb nearby WCDMA networks and cause problems to 3G cellular
phone communication in wide area. WCDMA Tx measurements should be performed at least in an
RF-shielded box and never with higher Tx power level than 0 dBm! Test full WCDMA Tx power only
in RF-shielded environment.

Also all measurements with an RF coupler should be performed in RF shielded environment because
nearby base stations can disturb sensitive receiver measurements. If there is no possibility to use
RF shielded environment, it should be checked that there are no transmissions on the same
frequencies as used in the tests.

The RF section of the phone is built around an N7500 RF ASIC with a GSM quad band dual PA and antenna
switch module, TXFEM, N7520, and a WCDMA PA, N7540.

The WCDMA PA needs a variable supply to work efficiently. This is provided by a switch mode power supply
component, N7541.

Please note that the grounding of the PA module is directly below the PA module. Therefore, it is difficult to
check or change the module.

Most RF semiconductors are static discharge sensitive. ESD procedures must be followed during repair, ground
straps and ESD soldering irons. RF ASICs, TXFEM, PA and SMPS are moisture sensitive, so parts must be pre-
baked prior to soldering.

In addition to key components, there are lot of discrete components (resistors, inductors and capacitors)
which troubleshooting is done mainly by checking if the soldering of the component is done properly.

A Capacitor can be checked for shorts and resistors for value by means of an ohmmeter, but be aware, in-
circuit measurements should be evaluated carefully.

Keep in mind that all measured voltages or RF levels in the service manual are rough figures. Especially RF
levels vary because of different measuring equipment or different grounding of the probe used. All spectrum
analyser measurements in this manual are made with a Fluke PM9639/011 10:1 (500 ohm) probe. It is
recommended that a similar kind of probe is used for all troubleshooting measurements.

When using an RF probe, use a pair of metallic tweezers to connect the probe ground to the PWB ground as
close to the measurement point as possible. If measurements are performed in a product specific module
jig, then “GND” pads should be used for the probe ground.
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 RF key component placement

Figure 50 RM-132 RF key component placement
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Figure 51 RM-133 RF key component placement
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 Self test troubleshooting

Troubleshooting flow
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 RF ASIC troubleshooting

Troubleshooting flow
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 Synthesizer troubleshooting

Troubleshooting flow
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Synthesizer test points

Measure RF ASIC N7505 RF ASIC N7500 Expected Result

VCTXCO output voltage G7501 pin 3 G7500 pin 3 38.4MHz 800 mVpp

RFCLKEXT 38.4MHz 500 mVpp

VCTXCO AFC voltage C7507 C7505 1V

Measure RF ASIC
N7505

RF ASIC
N7500

Expected
Result

VCO G7500 G7501 3526,4 MHz

Measure RF ASIC
N7505

RF ASIC
N7500

Expected
Result

VCO supply voltage L7515 C7509 2.8V

Measure RF ASIC
N7505

RF ASIC
N7500

Expected
Result

VCO control voltage C7516 C7510 1 to 3 V

RF ASIC N7505 RF ASIC N7500

C7516, C7511, R7501,
R7511

C7510, C7512, R7503,
R7504

 Receiver troubleshooting

Introduction to Rx troubleshooting
Rx can be tested by making a phone call or in the local mode. For the local mode testing, use Phoenix service
software.

The primary Rx troubleshooting parameter RSSI (Receiving Signal Strength Indicator). For GSM RSSI
measurement, see GSM Rx chain activation for manual measurements / GSM RSSI measurement
(page 7–12), and for the same measurement in WCDMA, see WCDMA RSSI measurement (page 7–13).

In GSM, the input signal can be either a real GSM signal or a CW (Continuous Wave) signal, which is 67.771
kHz above the carrier frequency.

In WCDMA, the input signal can be either a real WCDMA signal or a CW signal, which is 1 MHz above the carrier
frequency.

For service tool usage instructions, refer to section Service Tools and Service Concepts.

Related information
• WCDMA Rx chain activation for manual measurement (page 7–12)
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GSM Rx chain activation for manual measurements / GSM RSSI measurement

Context
RSSI signal measurement is the main Rx troubleshooting measurement. The test measures the strength of
the received signal.

I and Q branches can be measured separately. In GSM, the input signal can be either real GSM signal or a CW
(Continuous Wave) signal that is 67.771 kHz above the carrier frequency.

Steps
1. Start Phoenix service software.

2. Choose Testing→GSM→RSSI Reading .

3. Set the RF signal generator for channel frequency +67.771 kHz CW mode with –80 dBm signal.

Alternatively set the cellular tester downlink channel to the appropriate channel. Make sure that the tester
is set to continuous mode, not to burst mode.

4. In the RSSI Reading window, select the appropriate band and channel.

Figure 52 RSSI Reading window

5. To start the measurement, activate GSM Rx chain, click Start.

Results
RSSI reading values of the selected band and channel are displayed. The RSSI level must be the same value
which is set at the signal generator (-80 dBm).

WCDMA Rx chain activation for manual measurement

Steps
1. Start Phoenix service software.

2. Choose Testing→WCDMA→Rx Control .

3. In the Rx Control window:
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Figure 53 Rx Control window

• Set AGC Mode to Algorithm.

• Set Channel to 10700.

• Set AFC Algorithm to OFF (Default = OFF).

Next actions
When settings are ready, click Start to activate them.

If settings are changed later on (for example, you give a new channel number), you will need to click Stop
and Start again.

Note: Clicking Stop also disables Tx Control if that was active!

WCDMA RSSI measurement

Prerequisites
WCDMA Rx must be activated before RSSI can be measured. See WCDMA Rx chain activation for manual
measurement (page 7–12).

Steps
1. Start Phoenix service software.

2. Choose Testing→WCDMA→Rx Power Measurement .

3. In the Rx Power Measurement window, choose the following settings:

• Mode: RSSI

• Continuous Mode
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4. To perform the measurement, click Start.
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GSM receiver troubleshooting

Troubleshooting flow
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WCDMA receiver troubleshooting

Troubleshooting flow
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Receiver test points

Measure RF ASIC
N7505

RF ASIC N7500 Expected Result

RXIP J7508 J7508 400 mVpp and 700mVDC

RXIN U87 J7509 400 mVpp and 700mVDC

RXQP J7510 No test point 400 mVpp and 700mVDC

RXQN J7529 No test point 400 mVpp and 700mVDC

Band RF ASIC
N7505

RF ASIC 7500 Expected Result

GSM850 L7504 No test point 881,66771 MHz at 50dBm

GSM900 L7505 No test point 942,46771 MHz at 50dBm

GSM1800 L7501 C7515 1842,86771 MHz at
50dBm

GSM1900 L7500 C7514 1960,06771 MHz at
50dBm

 Transmitter troubleshooting

General instructions for Tx troubleshooting

Context
• Tx troubleshooting requires Tx operation.

• Do not transmit on frequencies that are in use.

• Transmitter can be controlled in the local mode for diagnostic purposes.

• The best diagnostic tool for GSM transmitter testing is RF Controls, and for the WCDMA transmitter
testing Tx Control.

Tx IQ tuning and Tx power tuning can be also used in some cases.

• Remember that retuning is not a repair procedure.

The first set of steps instructs how to assemble the test setup. This setup is general for all Tx troubleshooting
tasks.

Alternative steps provide specific troubleshooting instructions for Phoenix service software. The first section
is for the EGSM900/GSM1800/GSM1900 bands and the latter for WCDMA.

Caution: Never activate the GSM or WCDMA transmitter without a proper antenna load. There should
be always 50 ohm load connected to the RF connector (antenna, RF-measurement equipment or at
least 2 watts dummy load), otherwise GSM or WCDMA PA may be damaged.

Steps
1. Connect a module jig to a computer with a DAU-9S cable or to a FPS-10 flash prommer with a modular

cable.

Make sure that you have a PKD-1 dongle connected to the computer parallel port.
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2. Connect a DC power supply to a product-specific module jig.

Note: When repairing or tuning a transmitter, use an external DC supply with at least 3 A current
capability.

Set the DC supply voltage to 3.9 V.

3. Connect an RF cable between the RF connector of the product-specific module test jig and measurement
equipment or alternatively use a 50 ohms (at least 2 W) dummy load in the module test jig RF connector;
otherwise GSM or WCDMA PA may be damaged.

Note: There are three antenna connectors in the module jig:

• one for GSM

• one for WCDMA

• one for Bluetooth

Make sure that all connections are made to the correct RF connector.

Normally a spectrum analyser is used as measurement equipment.

Note: The maximum input power of a spectrum analyser is +30 dBm.

To prevent any damage, it is recommended to use 10 dB attenuator on the spectrum analyzer input.

4. Set Tx on.

i Place the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone (with FPS-10 use FBUS when using a DAU-9S cable and a COMBOX
driver).

iii Choose File→Open Product→xx-x* (* = type designator of the phone) or File→Scan Product. .

iv From the toolbar, set Operating mode to Local.

Alternative steps
• EGSM900/GSM1800/GSM1900 troubleshooting

i Choose Testing→GSM→RF Controls.

ii In the RF Controls window:

• Choose Band: GSM900 or GSM1800 or GSM1900 (Default = GSM900).

• Set Rx/Tx channel in the following way:

• GSM900: 37

• GSM1800: 700

• GSM1900: 661

• Set Active unit to Tx (Default = Rx).

• Set Operation Mode to Burst (Default = Burst).

• Set Edge to Off (Default).

• Set Tx Data Type to All 1 (Default = All 1).

• Set Tx PA Mode to High (Default).

• Set Tx Power Level in the following way:

• GSM900: 5 (Default = 19)

• GSM1800: 0 (Default = 15)

• GSM1900: 0 (Default = 15)

RM-132; RM-133
Nokia Customer Care RF Troubleshooting and Manual Tuning Guide

Page 7 –18 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Figure 54 RF Controls window

• WCDMA troubleshooting

i Choose Testing→WCDMA→Tx Control.

ii In the Tx Control window:

• Select the Algorithm mode tab.

• Set Start level to 0 dBm (Default = 0).

• Set Step size, Step count and Sequence to 0 (Default = 0).

• In the Scrambling code pane set Code class to LONG (Default = LONG), and Code to 16 (Default
= 16).

• For DPDCH  set the following values:

• Code number: 0

• Code class: 2

• Weight: 15

• For DPCCH set the following values:

• Code number: 0

• Code class: 2

• Weight: 8

• Set Channel to 9750.

• Check the DPDCH enabled check box (Default).
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Figure 55 Tx Control window

Next actions
When settings are done, click Send to enable them.

If you change the settings (e.g. give a new channel number), you need to click Stop and Send again.
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GSM transmitter troubleshooting

Troubleshooting flow
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WCDMA transmitter troubleshooting

Troubleshooting flow
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 Power amplifier (PA) and switch mode power supply (SMPS) troubleshooting

Troubleshooting flow

 RF tunings

Introduction to RF tunings
Phone RF is tuned in production. There is no reason to do the re-calibration unless:

• One or more of the RF components is changed

• FLASH memory chip (D5000) is changed or otherwise corrupted.
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Note: RF calibration is always performed with the help of a product-specific module jig, never with
an RF coupler. Using an RF coupler in the calibration phase will cause a complete mistuning of the
RF side.

Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken into account when the phone is tuned. As
all the RF losses are frequency dependent, the user have to be very careful and understand the measurement
setup. The following table presents the RF attenuations of the product-specific module jig:

Band Attenuation

GSM850 0.25dB

GSM900 0.25dB

GSM1800 0.4dB

GSM1900 0.45dB

WCDMA 2100 0.5dB

RF autotuning

Prerequisites
For information on the recommended test set-up, refer to the corresponding information on the Partner
Website or Nokia Online.

Before you can use the autotuning feature, the GPIB driver from the GPIB card vendor must be installed and
running.

The autotune .xml file must be in a correct place: C:\Program Files\Nokia\Phoenix\products\xx-x*
\rfconf_xx-x*.xml (*= indicates the type designator of the phone, e.g. RM-1)

Context
RF autotuning is performed with the aid of a digital radio communication tester.

Autotuning covers all RF tunings that are needed to perform after RF component repairs.

Note: Do not perform RF autotuning without a proper reason. Autotuning may only be performed
after component repairs or if the RF tuning information is lost.

Steps
1. Connect the communication tester to the GPIB bus.

2. Start Phoenix service software.

3. Choose Tools→Options→GPIB Card.

4. From the Card Type drop-down menu, choose the GPIB card used, then click Start.

The name of the communication tester appears in the Listeners pane.
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5. To specify the cable loss from a module jig to the communication tester, choose Set Loss from the
Tuning menu.

6. In the Set Loss window, click the Jig tab, and select the right jig for the phone from the drop-down list.

Alternatively, you can add a new jig by clicking Add, and selecting the desired jig from the list.

7. Click the Cable tab and add the extra cable attenuation.

8. To start autotuning, choose Auto-Tune from the Tuning menu.

9. In the Auto-Tune window, click Options.

10. In the Auto-Tune options window, ensure the Enable showing of message boxes check box is checked,
and click OK.
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11. Connect the phone WCDMA RF port to the communication tester, and click Tune.

12. Change the phone RF adapter from WCDMA port to GSM port.

13. To complete the RF autotuning, click OK.

Results
Autotuning completed successfully! message appears.
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RF manual tuning guide

Required manual tunings after component changes
Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

If, however, manual tuning is used, only relevant tunings should be performed. Refer to the following table:

Changed component Perform the following tunings

RF ASIC N7500 RF Channel Filter Calibration, Temperature Sensor
Calibration, Rx calibration (GSM), Rx band filter
response compensation (GSM), TxIQ Tuning (GSM),
Tx Power Level Tuning (GSM), Rx calibration
(WCDMA), Tx AGC & Power Detector (WCDMA), Tx
Band Response Calibration (WCDMA), Tx LO Leakage
(WCDMA)

Any component in the GSM TX RF chain before the
PA

Tx IQ Tuning, Tx Power Level Tuning

Any component in the GSM TX RF chain after the PA
or PA

Tx Power Level Tuning

Any component in the WCDMA TX RF chain before
the PA

Tx AGC & Power Detector, Tx Band Response
Calibration, Tx LO Leakage

Any component in the WCDMA TX RX chain after the
PA, PA, power detector or PA switch mode power
supply

Tx AGC & Power Detector, Tx Band Response
Calibration, PA Detection

Any component in the GSM RX chain Rx Calibration, RX Band Filter Response
Compensation

Any component in the WCDMA RX chain Rx AGC Alignment, RX Band Response Calibration

VCTCXO G7500 Rx Calibration (GSM900 band)
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System mode independent manual tunings

RF channel filter calibration

Context
RF channel filter calibration tunes RF ASIC's internal low pass filters that limit the bandwidth of BB IQ signals.

One common calibration is made for GSM and WCDMA.

Table 16 RF channel filter calibration tuning limits

Min Typ Max

Tx filter 0 10 31

Rx filter 0 16 31

Steps
1. From the "Operating mode" dropdown menu, set mode to "Local".

2. From the Tuning menu, choose "RF Channel Filter Calibration".

3. Click Tune.

4. To save the values to the PMM (Permanent Memory) area, click Write.

5. To close the tuning window, click Close.

Results

Figure 56 RF channel filter calibration typical values

PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .

3. Click Tune.
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4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

Temperature sensor calibration

Context
There is a temperature sensor intergrated into the RF ASIC. The RF ASIC produces a DC-voltage, which is
temperature dependent.

Temperature sensor calibration is done in room temperature, in which offsets caused by variations with Rx/
Tx ASIC and the AD-converter inside EM ASIC N2200, are removed.

The engine calibrates itself, no external equipment is required.

The temperature of the engine must be 23°C plus or minus two degrees.

Steps
1. From the "Operating mode" dropdown menu, set mode to "Local".

2. From the Tuning menu, choose "Temperature Sensor Calibration".

3. Click "Tune".

Table 17 Temperature sensor calibration tuning limits

Min Typ Max Unit

-20 -4 20 V

4. To save the calibration values, click "Write".

5. To finish the calibration, click "Close".

GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the module jig’s GSM connector to signal generator.

2. From the "Operating mode" dropdown menu, set mode to "Local".
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3. From the Tuning menu, choose GSM -> Rx Calibration.

4. Check the “Load from Phone” check box and clear the “Save to Phone” check box.

5. From the Band dropdown menu, choose GSM900.

6. Click Start (if not active already).

7. Click Calibrate.
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8. Connect signal generator to the phone and set frequency and amplitude as instructed in the "Rx
Calibration with band EGSM900" popup window.

The calibration uses a non-modulated CW signal. Increase the signal generator level by cable attenuation
and module jig probe attenuation!

9. To perform tuning, click OK.

10. Check that the tuning values are within the limits specified in this table:

Table 18 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM850

RSSI0 106 109...110 114 dB

GSM900

AFC Value -200 -105...62 200

AFC slope 0 122 200

RSSI0 106 107...110 114 dB

GSM1800

RSSI0 104 104...109 114 dB

GSM1900

RSSI0 104 104...109 114 dB
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11. To save values to the phone, click "Save & Continue".

12. Repeat steps 3 to 8 for GSM850, GSM1800 and GSM1900.
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Results

Rx band filter response compensation (GSM)

Prerequisites
Rx Calibration must be performed before the Rx Band Filter Response Compensation.

Context
On each GSM Rx band, there is a band rejecting filter in front of the LNA (Low Noise Amplifier). The amplitude
ripple caused by these filters causes ripple to the RSSI measurement and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect the module jig’s GSM connector to the signal generator.

2. From the "Operating mode" dropdown menu, set mode to "Local".

3. Select GSM900 band.
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4. From the Tuning menu, choose GSM -> Rx Band Filter Response Compensation.

5. In the Tuning mode pane, select Manual.

6. Click Start.

RM-132; RM-133
Nokia Customer Care RF Troubleshooting and Manual Tuning Guide

Page 7 –34 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



7. Click Save & Continue.

8. Connect the signal generator to the phone and set frequency and amplitude as instructed in the "Rx
Band Filter Response Compensation for EGSM900" popup window.

9. To perform tuning, click OK.

10. Go through all 9 frequencies.
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11. Check that the tuning values are within the limits specified in the following table:

Min Typ Max Unit

GSM850

Ch. 118/867.26771 MHz -10 -1 5 dB

Ch. 128/869.26771 MHz -3 0 5 dB

Ch. 140/871.66771 MHz -3 0 5 dB

Ch. 172/878.06771 MHz -3 0 5 dB

Ch. 190/881.66771 MHz -3 0 5 dB

Ch. 217/887.06771 MHz -3 0 5 dB

Ch. 241/891.86771 MHz -3 0 5 dB

Ch. 251/893.86771 MHz -3 0 5 dB

Ch. 261/895.86771 MHz -10 1 5 dB

GSM900

Ch. 965 / 923.26771 MHz -10 -1 5 dB

Ch. 975 / 925.26771 MHz -3 0 5 dB

Ch. 987 / 927.66771 MHz -3 0 5 dB

Ch. 1009 / 932.06771 MHz -3 0 5 dB

Ch. 37 / 942.46771 MHz -3 0 5 dB

Ch. 90 / 953.06771 MHz -3 0 5 dB

Ch. 114 / 957.86771 MHz -3 0 5 dB

Ch. 124 / 959.86771 MHz -3 0 5 dB

Ch. 136 / 962.26771 MHz -10 -1 5

GSM1800

Ch. 497 / 1802.26771 MHz -10 -1 5 dB

Ch. 512 / 1805.26771 MHz -3 0 5 dB

Ch. 535 / 1809.86771 MHz -3 0 5 dB

Ch. 606 / 1824.06771 MHz -3 0 5 dB

Ch. 700 / 1842.86771 MHz -3 0 5 dB

Ch. 791 / 1861.06771 MHz -3 0 5 dB

Ch. 870 / 1876.86771 MHz -3 0 5 dB

Ch. 885 / 1879.86771 MHz -3 0 5 dB

Ch. 908 / 1884.46771 MHz -10 -1 5 dB

GSM1900

Ch. 496 / 1927.06771 MHz -10 -1 5 dB

Ch. 512 / 1930.26771 MHz -3 0 5 dB

RM-132; RM-133
Nokia Customer Care RF Troubleshooting and Manual Tuning Guide

Page 7 –36 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Min Typ Max Unit

Ch. 537 / 1935.26771 MHz -3 0 5 dB

Ch. 586 / 1945.06771 MHz -3 0 5 dB

Ch. 661 / 1960.06771 MHz -3 0 5 dB

Ch. 736 / 1975.06771 MHz -3 0 5 dB

Ch. 794 / 1986.66771 MHz -3 0 5 dB

Ch. 810 / 1989.86771 MHz -3 0 5 dB

Ch. 835 / 1994.86771 MHz -10 -1 5 dB

12. If the values are within the limits, click "Save & Continue".

13. Repeat the steps 4 to 10 for GSM850, GSM1800 and GSM1900.
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Results

GSM transmitter tunings

Tx IQ tuning (GSM)

Context
• The Tx path branches to I and Q signals at RF I/Q modulator. Modulator and analog hardware located after

it cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning balances the I and
Q branches.

• Tx IQ tuning must be performed on all GSM bands.

Steps
1. From the dropdown menus, set "Operating mode" to Local, "System mode" to GSM, and "Band" to GSM900.
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2. From the Tuning menu, choose GSM -> Tx IQ Tuning.

3. Set "Mode" to Automatic and "Edge" to Off.

4. Click Start.

Wait until automatic tuning has finished and moved the sliders.

Values are written to the phone memory automatically.
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5. When the values have been written to the phone memory, click Next to change to the next band.

6. When all bands have been tuned, click Finish and Close to end the tuning procedure.

Next actions
Tuning sliders should be close to the center of the scale after the tuning and within the limits specified in
the following table. If they are not within the limits, check Tx IQ quality manually.

Min Typ Max Unit

GSM850/GSM900

I DC offset / Q DC
offset

-6 -4 4 6 dB

Ampl -1 0 1 dB

Phase 85 90 95 dB

GSM1800/GSM1900

I/Q DC -6 0.5 6 dB

Ampl -1 0 1 dB

Phase 95 100 110 dB

Tx power level tuning (GSM)

Context
Because of variations at IC process and discrete component values, the actual transmitter RF gain of each
phone is different. Tx power level tuning is used to find out mapping factors called 'power coefficients’. These
adjust the GSM transmitter output power to fulfill the specifications.
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For EDGE transmission the bias settings of the GSM PA are adjusted in order to improve linearity. This affects
the PA gain and hence the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a power meter with peak power detector or Agilent VSA Transmitter Tester.

2. Start Phoenix service software.

3. From the "Operating mode" dropdown menu, set mode to "Local".

4. From the Tuning menu, choose GSM -> Tx Power Level Tuning.

5. If you are using an Agilent VSA use the settings in the table below.

Agilent VSA Transmitter Tester specific settings

GSM850 Frequency (MHz) 836.6

GSM900 Frequency (MHz) 897.4

GSM1800 Frequency (MHz) 1747.8

GSM1900 Frequency (MHz) 1880

Resolution Bandwidth (MHz) 3

Video Bandwidth (MHz) 3

Trigger Video

Sweeptime (ms) 1

Span zero

Average (for non-EDGE) 10

Average (for EDGE) 50
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6. Click Start.

7. Select band. Set power meter or VSA to the correct frequency. Click Read and then Tune.
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8. Adjust power levels 5, 15 and 19 to correspond the "Target dBm" column by pressing + or – keys.

Check that the coeffiecient values are within the limits specified in the following table.

Min Typ Max

GSM850

PL5 coefficient 0.45 0.635 0.73

PL15 coefficient 0.238

PL19 coefficient 0.12 0.185 0.3

GSM850 EDGE

PL8 coefficient 0.35 0.466 0.6

PL15 coefficient 0.258

PL19 coefficient 0.12 0.201 0.3

GSM900

PL5 coefficient 0.45 0.648 0.73

PL15 coefficient 0.241

PL19 coefficient 0.12 0.188 0.3

GSM900 EDGE
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Min Typ Max

PL8 coefficient 0.35 0.47 0.6

PL15 coefficient 0.261

PL19 coefficient 0.12 0.203 0.3

GSM1800

PL0 coefficient 0.45 0.597 0.7

PL11 coefficient 0.18

PL15 coefficient 0.05 0.147 0.3

GSM1800 EDGE

PL2 coefficient 0.35 0.446 0.6

PL11 coefficient 0.197

PL15 coefficient 0.05 0.161 0.3

GSM1900

PL0 coefficient 0.45 0.536 0.7

PL11 coefficient 0.19

PL15 coefficient 0.05 0.158 0.3

GSM1900 EDGE

PL2 coefficient 0.35 0.429 0.6

PL11 coefficient 0.208

PL15 coefficient 0.05 0.175 0.3

9. If the values are within the limits, click "Calculate,Write & Finish". Repeat steps 7 to 9. for each band that
needs tuning.

10. When tuning EDGE with the VSA use 50 averages and 10 averages for non-EDGE.

11. Tune EDGE power levels to the corresponding target power levels.

Only power levels 8, 15 and 19 are tuned in GSM850/GSM900 and 2, 10 and 15 in GSM1800/1900.

12. When the tuning is completed, close the Tx Power Level Tuning window.

WCDMA receiver tunings

RX calibration (WCDMA)

Context
Rx calibration tuning routine calculates the real gain values of the WCDMA Rx AGC system. There is also a SAW
filter between front end LNA and mixer in the receive chain, which causes ripple in the RSSI measurement,
this is calibrated out. The SAW filter is intergated into RF ASIC N7500.

Rx calibration can be done in two different ways, manual tune and sweep mode tune. If the signal generator
in use supports frequency sweep table, the calibration is done in one step.

Steps
1. For manual tuning, set mode to Local in the Operating Mode dropdown menu.
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2. In the Tuning menu, choose WCDMA→Rx Calibration  .

3. Click Start.

4. Select Band.

5. Click Tune.

6. Setup the signal generator to correspond with the values on the, Rx Calibration pop-up window and
click OK.

Figure 57 Pop-up window for WCDMA2100

7. Repeat step 6. for Middle and High channels.

8. Ensure Tuning Results are within limits specified in the table below:

If values are OK, click Write to save the values.
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Band Min Typ Max Unit

Rx chain 2100 -6 1.5 to 3.5 6 dB

Low
Frequency

-5 -0.7 to 4.0 5

High
Frequency

-5 -0.7 to 4.0 5

Alternative steps
• For sweep mode tuning, set Mode to Local in the Operating Mode dropdown menu.

• In the Tuning menu, choose WCDMA→ Rx Calibration .

• Click Start.

• Select Band.

• Check the Sweep Mode box.

• Click Tune.

• Setup the signal generator to correspond with the values on the Rx Calibration pop-up window and
click OK.

Figure 58 Pop-up window for WCDMA2100

• Ensure Tuning Results are within limits specified in the table above: If values are OK, click Write to save
the values to the phone.

• Close the tuning window.

WCDMA transmitter tunings

Tx AGC & power detector (WCDMA)

Context
Tx AGC & power detector tuning has two purposes:

• to enable the phone to select the correct TxC value accurately in order to produce the required RF level

• to enable the phone to measure its own transmitter power accurately

There are two ways to perform the tuning. For an alternative method, see Alternative steps (page 7–52).

Steps
1. From the Operating mode drop-down menu, set mode to Local.
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2. Choose Tuning→WCDMA→Tx AGC & Power Detector.

3. Click Start.

4. In theWide Range pane, click Tune (the leftmost Tune button).

5. Set up the spectrum analyzer in the following way:

6. After setting the spectrum analyzer, click OK.

7. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second from 750 us, the third on 1220 us
and so on in every 500 us until the table is filled.

Note: It must be possible to measure power levels down to –68 dBm. The measured power levels
must be monotonously decreasing.

Make sure that the marker is not measuring the level of noise spike on lower levels.
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8. Fill in the power level values (in dBm) to the Wide Range table.

9. In the Wide Range pane, click Calculate.

10. In the High Burst pane, click Tune.

11. Adjust the spectrum analyzer according to the following settings:
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12. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second from 750 us, third on 1220 us and
so on in every 500 us until the table is filled.

Figure 59 High burst measurement

13. In the High Burst pane, click Calculate.

14. Check that the calculated values are within the limits specified in the following table:

Min Max

C0-high -0.5 5

C1-high -50 50

C2-high 400 900

C0-mid -0.7 0.7

C1-mid 0 50

C2-mid 400 900

C0-low -4 4

C1-low -400 440

C2-low -10000 15000
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Min Max

Det-k 100 220

Det-b 0 150

15. To save the coefficients to the phone, click Write.

16. To close the Tx AGC & Power Detector window, click Close.

17. Choose Testing→WCDMA→ Tx Control.

18. Select the Algorithm mode tab.

19. Write the target power level 25 dBm to the Start level line and check the Max power limit check box
(detector calibration check).

20. Setup the spectrum analyzer with the following settings:

Center frequency: 1950.3 MHz

Span: 0 Hz

Reference level offset: Cable attenuations + adapter attenuation

Reference level: 24 dBm or -20 dBm depending on the level
measured

Input attenuation: Automatic

Resolution bandwidth: 5 MHz

Video bandwidth: 5 MHz

Sweep time: 20 ms
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Detector: RMS detector

Average: No

Trigger: Free run

21. Click Send.

22. Measure the WCDMA output power.

It should be around 21 dBm.

23. Click RF Stop and uncheck the Max power limit check box.

24. Repeat steps 19 to 23 for levels +19, +7, 0, -20 and –40 dBm.

The measured output power may not differ more than +-2 dB from the requested value at level +19 dBm
and no more than +-4 dB on lower levels.

Remember to stop the RF before sending new data.

Alternative steps
• Measure the wide range levels normally and write down the levels that are possible to measure.

• Click Finish.

• Click Options.

• Change the first wide range DAC value to 573 and change the number of tuning steps to 21.

• Change the spectrum analyzer reference level to –20 dBm and adjust the input attenuator to the lowest
value possible.

• In the Wide Range pane, click Tune and fill in the rest of values starting from the 19th level.

Tx band response calibration (WCDMA)

Context
The purpose of this tuning operation is to calibrate the WCDMA Tx performance. It defines the power detector
and Tx frequency compensation values. However, before starting this tuning procedure, it is necessary to
carry out Tx AGC & Power Detector Calibration tuning. This is because its results will be needed for this tuning
operation.

• In the Tuning Settings pane, it is possible to edit the numbers of channels used in this tuning operation.

• If the Calibrate Detector Response check box is checked, only Tx response is calibrated. Zero is written
to the power detector compensation values block in the permanent memory (PM) of the terminal.

• Detector Calibration level shows the power level used for calibrating the power detector in this tuning
procedure.

• Tx Calibration level shows the power level used for calibrating tx frequency in this tuning procedure.

• In Measured Power Levels pane, you can insert the dBm values read from the power meter.

• In Tuned Values pane, the values that are stored in the permanent memory (PM) of the terminal in Current
columns are shown.

• New values are added to New column when the Calculate button is clicked.

• Abort button aborts the tuning operation without saving the tuned values.

• Read button reads the tuned values in the PM of the terminal, and displays them in the Tuned Values pane
in in the Current column.

Steps
1. Start Phoenix service software.
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2. Choose File→Scan Product  .

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→WCDMA→Tx Band Response Calibration .

5. Click Start.

The current values are shown in the Tuned Values pane.

6. Click Tune.

7. Connect the power meter to the terminal, and set it to Channel Mid frequency.

8. Read the values of slot 0 and slot 1 from the power meter and enter them to Middle power level fields
in the Measured Power Levels pane.

Slot 0 is used for detector calibration and slot 1 for Tx calibration.

9. Click Next.

10. Switch the power meter to Channel Low frequency.

11. Read the values from the power meter, and enter them to Low power level fields.

12. Switch the power meter to Channel High frequency.

13. Read the values from the power meter, and enter them to High power level fields.

14. Click Next.

15. Click Calculate.

The tuned values are shown in the Tuned Values pane in the New column.

16. Check that the tuned values are within the limits presented in the following table. If they are OK, click
Yes.
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Min Max

Tx Freq Comp (the first and last
value)

-4 +4

17. To save the tuned values to the terminal, click Write.

18. Close the Tx Band Response Calibration window.

Tx LO leakage (WCDMA)

Context
The purpose of Tx LO leakage tuning is to minimize the carrier leakage of the IQ-modulator which is caused
by the DC offset voltages in the Tx IQ-signal lines and in the actual IQ modulator.

The tuning improves WCDMA Tx AGC dynamics at low power levels. A self-calibration routine selects the best
combination for internal control words in order to produce minimum LO leakage.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→WCDMA→ Tx LO Leakage .

3. Click Tune.

4. To end the tuning, click Close.

 Antenna troubleshooting

Context
The antennas have contacts with the engine PWB via three pogo pins.

The mechanical construction and antenna are described below.
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Symptoms anticipated:

• radiated power degradation, e.g. signal bar is low compared to other phones

Required equipment:

• call test

• ASM coupler

• RF cables

You can use the following table for the coupling loss for the main GSM coupler; you may also need to include
RF cable loss.

Attenuation values for inductive RF coupler SA-112

Band Channel Attenuation
RX

Tolerance RX Attenuation
TX

Tolerance TX Reported
power

GSM 850

Low 128 11.8

+/-4.5dB

14.2

+/-4.5dB 31.7'+/-4.5dB

Mid 189 11.1 13.6

High 251 10 12.9
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Attenuation values for inductive RF coupler SA-112

Band Channel Attenuation
RX

Tolerance RX Attenuation
TX

Tolerance TX Reported
power

GSM 900

Low 975 8.9

+/-4.5dB

11.1

+/-4.5dB 31.5'+/-4.5dB

Mid 62 8.7 9.8

High 124 8.8 9.2

GSM
1800

Low 513 19.6

+/-4.5dB

24

+/-4.5dB 28.7'+/-4.5dB

Mid 700 17.9 21.3

High 884 16.2 20.7

GSM
1900

Low 513 14.2

+/-4.5dB

17.9

+/-4.5dB 28.6'+/-4.5dB

Mid 661 13.3 16.2

High 809 13 14.9

WCDMA

Low 16.1 +/-4.5dB 21.3 +/-4.5dB 23'+/-4.5dBBand I

Steps
1. Place the phone into the AMS coupler jig, establish a call and set the path loss using the above attenuation

TX.

2. Check the report power level for the UE. If it is not in the target range, e.g. 31.7+/-4.5dB (31.7-4.5 to 31.7
+4.5) for 850 TX, it may indicate that one of the antenna pogo pins may not contact to the PWB.

3. Replace the antenna.

4. Repeat steps 2 and 3. If the power level is within the target range, the replaced antenna was broken;
otherwise, other RF part might not function properly. In this case RF troubleshooting should be carried
out.
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Introduction to camera module troubleshooting

Background, tools and terminology
Faults or complaints in camera operation can be roughly categorised into three subgroups:

1 Camera is not functional at all; no image can be taken.

2 Images can be taken but there is nothing recognizable in them.

3 Images can be taken and they are recognizable but for some reason the quality of images is seriously
degraded, or customer complains about image quality.

Image quality is very hard to measure quantitatively, and even comparative measurements are difficult
(comparing two images) to do, if the difference is small. Especially if the user is not satisfied with his/her
device's image quality, and tells, for example, that the images are not sharp, it is fairly difficult to accurately
test the device and get an exact figure which would tell whether the device is functioning properly.

Often subjective evaluation has to be used for finding out if a certain property of the camera is acceptable
or not. Some training or experience of a correctly operating reference device may be needed in order to
detect what actually is wrong, or is there anything wrong at all.

It is easy for the user to take bad images in bad conditions. Therefore the camera operation has to be checked
always in constant conditions (lighting, temperature) or by using a second, known-to-be good device as
reference. Experience helps significantly in analysing image quality.

Terms

Autofocus Camera module contains lens movement mechanics for focus adjustment.
Autofocus enables camera to take sharp images of objects positioned
between 10cm to infinity. During AF the viewfinder image will be
momentarily blurred as the camera searches for the right focus setting.

Digital zoom Digital zoom is done by first cropping the image by the zoom ratio and
then upscaling it to the output resolution. This will decrease the image
quality especially with high zoom ratios.

Dynamic range Camera's ability to capture details in dark and bright areas of the scene
simultaneously.

Exposure time Camera modules use silicon sensor to collect light and for forming an
image. The imaging process roughly corresponds to traditional film
photography, in which exposure time means the time during which the
film is exposed to light coming through optics. Increasing the time will
allow for more light hitting the film and thus results in brighter image. The
operation principle is exactly the same with silicon sensor, but the shutter
functionality is handled electronically i.e. there is no mechanical moving
parts like in film cameras.

Flicker Phenomenon, which is caused by pulsating in scene lighting, typically
appearing as wide horizontal stripes in an image.

ND-filter Neutral density filter is a filter which is used in very bright conditions to
reduce the amount of light hitting the sensor. The filter is built into the
camera module and applied automatically when needed.

Noise Variation of response between pixels with same level of input illumination.

Resolution Usually the amount of pixels in the camera sensor. In some occasions the
term resolution is used for describing the sharpness of the images.
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Sensitivity Camera module's sensitivity to light. In equivalent illumination conditions,
a less sensitive camera needs a longer exposure time to gather enough
light in forming a good image. Analogous to ISO speed in photographic
film.

Sharpness Good quality images are 'sharp' or 'crisp', meaning that image details are
well visible in the picture. However, certain issues, such as non-idealities
in optics, cause image blurring, making objects in picture to appear 'soft'.
Each camera type typically has its own level of performance.

Shutter The electronic shutter is used when short exposure times are needed and
in video. When the mechanical shutter is used a black sheet will cover the
lens after the exposure.

The effect of image taking conditions on image quality
There are some factors, which may cause poor image quality, if not taken into account by the end user when
shooting images, and thus may result in complaints. The items listed are normal to camera operation and
are not a reason for changing the camera module.

Autofocus
When the camera is focusing a lens is moved inside the module to give the sharpest possible image. This
camera module is specified to operate satisfactorily from 10 cm to infinite distance of scene objects. Trying
to photograph objects closer than 10 cm is likely to result in a blurred out of focus image. The lack of sharpness
is first visible in full resolution images. Images taken very close to the subject, a limited depth of focus will
be visible, that is the upper or lower parts of the image may be out of focus. This is normal; do not change
the camera module.

Figure 60 Only center part of image is in focus due to limited depth of focus

The amount of light available
In dim conditions camera runs out of sensitivity. The exposure time is long (especially in the night mode)
and the risk of getting shaken (= blurred) images increases. In addition, image noise level grows. The
maximum exposure time in the night mode is ¼ seconds. Therefore, images need to be taken with extreme
care and by supporting the phone when the amount of light reflected from the target is low. Because of the
longer exposure time and larger gain value, noise level increases in low light conditions. Sometimes blurring
may even occur in daytime, if the image is taken very carelessly. See the figure below for an example. This
is normal; do not change the camera module.
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Figure 61 Blurring caused by shaking hands

Movement in bright light
If an image is taken of moving objects or if the device is used in a moving vehicle, object 'skewing' or 'tilting'
may occur. This phenomenon is fundamental to most CMOS camera types, and may happen when using the
electronic shutter. The movement of camera or object sometimes cause blurring indoors or in dim lighting
conditions because of long exposure time. This is normal; do not change the camera module.

Figure 62 Near objects get skewed when taking images from a moving vehicle

Temperature
High temperatures inside the mobile phone cause more noise to appear in images. For example, in +70
degrees (Celsius), the noise level may be very high, and it further grows if the conditions are dim. If the phone
processor has been heavily loaded for a long time before taking an image, the phone might have considerably
higher temperature inside than in the surrounding environment. This is also normal to camera operation;
do not change the camera module.
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Figure 63 Noisy image taken in +70 degrees Celsius

Phone display
If the display contrast is set too dark, the image quality degrades: the images may be very dark depending
on the setting. If the display contrast is set too bright, image contrast appears bad and "faint". This problem
is solved by setting the display contrast correctly. This is normal behaviour; do not change the camera module.

Basic rules of photography (especially shooting against light)
Because of dynamic range limitations, taking images against bright light might cause either saturated image
or the actual target appear too dark. In practice, this means that when taking an image indoors and having,
for example, a window behind the object, the result is usually poor. This is normal behaviour; do not change
the camera module.

Figure 64 Image taken against light

Flicker
In some occasions a bright fluorescent light may cause flicker in the viewfinder and captured image. This
phenomenon may also be a result, if images are taken indoors under the mismatch of 50/60 Hz electricity
network frequency. The electricity frequency used is automatically detected by the camera module. In some
very few countries, both 50 and 60 Hz networks are present and thus probability for the phenomenon
increases. Flickering occurs also under high artificial illumination level. Flickering only occurs when the rolling
shutter is used. This is normal behaviour; do not change the camera module.
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Figure 65 Flicker in an image; object illuminated by strong fluorescent light

Bright light outside of image view
Especially the sun can cause clearly visible lens glare phenomenon and poor contrast in images. This happens
because of undesired reflections inside the camera optics. Generally this kind of reflections are common in
all optical systems. This is normal behaviour; do not change the camera module.

Figure 66 A lens reflection effect caused by sunshine
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Examples of good quality images

Figure 67 Good image taken indoors

Figure 68 Good image taken outdoors

 Image quality analysis

Possible faults in image quality
When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
may be expected to appear:

• Dust (black spots)

• Lack of sharpness

• Bit errors

In addition, there are many other kinds of possibilities for bad image quality, but those are ruled out from
the scope of this document since the probability of their appearance is small.
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Testing for dust in camera module

Symptoms and diagnosis
For detecting these kinds of problems, take an image of a uniform white surface and analyse it in full
resolution. A good quality PC monitor is preferred for analysis. Search carefully, since finding these defects
is not always easy. Figure "Effects of dust on optical path" is an example image containing easily detectable
dust problems.

When taking a white image, use uniformly lightened white paper or white wall. One possibility is to use
uniform light but in this case make sure that the camera image is not flickering when taking the test image.
In case flickering happens, try to reduce illumination level. Use JPEG image format for analysing, and set the
image quality parameter to ‘High Quality’.

Black spots in an image are caused by dirt particles trapped inside the optical system. Clearly visible and
sharp edged black dots in an image are typically dust particles on the image sensor. These spots are searched
for in the manufacturing phase, but it is possible that the camera body cavity contains a particle, which may
move onto the image sensor active surface, for example, when the phone is dropped. Thus it is also possible
that the problem will disappear before the phone is brought to service. The camera should be replaced if the
problem is present when the service technician analyses the phone.

If a dust particle is lying on the infrared filter surface on either side, they are hard to locate because they are
out of focus, and appear in the image as large, grayish and fading-edge 'blobs'. Sometimes they are invisible
to the eye, and thus the user probably does not notice them at all. However, it is possible that a larger particle
disturbs the user, causing need for service.

Figure 69 Effects of dust on optical path

If large dust particles get trapped on top of the lens surface in the cavity between camera window and lens,
they will cause image blurring and poor contrast. The dust gasket between the window and lens should
prevent any particles from getting into the cavity after the manufacturing phase.

If dust particles are found on the sensor, this is classified as a manufacturing error of the module and the
camera should be replaced. Any particles inside the cavity between the protection window and lens have
most probably been trapped there in the assembly phase at a Nokia factory. Unauthorized disassembling of
the product can also be the root of the problem. However, in most cases it should be possible to remove the
particle(s) by using clean compressed air. Never wipe the lens surface before trying compressed air; the
possibility of damaging the lens is substantial. Always check the image sharpness after removing dust.
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Testing camera image sharpness

Symptoms and diagnosis
If pictures taken with a device are claimed to be blurry, there are five possible sources for the problem:

1 The protection window is fingerprinted, soiled, dirty, visibly scratched or broken.

2 The camera module has failed to focus correctly, producing a blurred image.

3 User has tried to take pictures and images are blurred due to handshake, shutter button pressing, dark
conditions or carelessness.

4 There is dirt between the protection window and the camera lens.

5 The protection window is defective. This can be either a manufacturing failure or caused by the user. The
window should be changed.

A quantitative analysis of sharpness is very difficult to conduct in any other environment than optics
laboratory. Therefore, subjective analysis should be used.

If no visible defects (items 1-4) are found, a couple of test images should be taken. Generally, a well-
illuminated typical indoor scene, such as the one in Figure "Good image taken indoors", can be used as a
target. The main considerations are:

• The camera module has to be given time to focus correctly. Correct focusing is normally indicated with a
flashing icon or green bracket in the viewfinder. During focusing, the image in the viewfinder moves
slightly back and fourth, this is normal and shows that the lens unit is moving. During the movement a
faint sound can be heard from the camera head.

• The protection window has to be clean.

• The amount of light (300 – 600 lux (bright office lighting)) is sufficient.

• The scene should contain, for example, small objects for checking sharpness. Their distance should be 1
– 2 meters.

• If possible, compare the image to another image of the same scene, taken with a different device. Note
that the reference device has to be a similar Nokia phone.

There are several conditions in which AF operation is challenging for the camera module, i.e. failing from
time to time. These include:

• Low light scenes and night mode

• Scenes with low contrast

• Fast-moving objects

AF operation is disabled on purpose in “night”, “landscape”, “sports”, and “video” modes. When using these
modes the lens is set to a predetermined focal position and isn’t moved during use.

Under low light and night mode the AF function is slower than under good light, it may even fail to find
correct focus position. Low contrast scenes or fast moving objects may also slow down or cause AF to fail.
This is normal operation, and is not a cause to replace camera.

The operation of AF can be tested by taking images of objects at different distances. Good distances are 30
cm, 60 cm and infinity (>3 m). Any LED or xenon flashes should not be used while taking the images.

The taken images should be analysed on PC screen at 100% scaling simultaneously with a reference image.
Pay attention to the computer display settings; at least 65000 colors (16 bit) have to be used. 256 (8-bit)
color setting is not sufficient; true color (24 bit, 16 million colors) or 32 bit (full color) setting is recommended.

If the differences are noticeable at a glance and also if the one under investigation is significantly inferior,
the module might have a faulty lens. In this case, the module should be changed. Always recheck the
resolution after changing the camera module. If a different module produces a clearly noticeable quality gap,
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the fault is probably in the camera window. Check the window by looking carefully through it when replacing
the module. As references Figure "Good image taken indoors" and Figure "Good image taken outdoors" can
be used. Another possibility is to use a service point comparison phone, if available.

Effects of dirty or defective camera lens protection window
The following series of images demonstrates the effects of fingerprints on the camera protection window.

Note: The effects of any dirt in images can vary very much; it may be difficult to judge if the window
has been dirty when some image has been taken or if something else has been wrong. That is why
the cleanness of the protection window should always be checked and the window should be wiped
clean with a suitable cloth.

Figure 70 Image taken with clear protection window

Figure 71 Image taken with greasy protection window

Bright point light sources might cause images that have flares around the light source if the protection
window is dirty. A smeared fingerprint may be hard to see on the protective window but if will affect the
image quality. These flares can be avoided by cleaning the window with a suitable cloth.

RM-132; RM-133
Camera Module Troubleshooting Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 8 –13
Copyright © 2006 Nokia. All rights reserved.



Figure 72 Image of point light sources taken with a clean protective window

Figure 73 Image of point light sources taken with a dirty (finger print) protective window

Faulty pixels in images
Faulty pixels are pixels that do not respond to light in the same way as the pixels around them. There are
three main types of faulty pixels, dead, stuck and hot pixels.

Dead pixels are always black or significantly darker than their surrounding. Dead pixels appear as black spots
in all lightning conditions. Camera modules producing images with dead pixels that are clearly noticeable
should be replaced.

If the pixel remains always saturated to its maximum value it is stuck. Stuck pixels may appear as red, green,
blue or white spots in all lightning conditions. Camera modules producing images with one or more stuck
pixels should be replaced.

Hot pixels are pixels that easily saturate in dim light conditions. It is normal to get a lot of noise and hot
pixels in night conditions or otherwise dark conditions. The hot pixels should disappear when the ambient
light is increased, but may still appear in darker areas of an otherwise well illuminated scene.

When examining an image for defect pixels, test images should be viewed as 100% enlargements on a PC
monitor.
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Figure 74 Enlargement of a hot pixel

Flash photography problems
Use of flash device may affect the image in many ways.

• White balance errors. The image may get a wrong tone due to mixing of flash colour temperature and
ambient lightning. This is unwanted but normal feature.

• Dust reflections. Dust or water drops in front of the flash unit may reflect strongly to the camera sensor.
See the following figure.

Figure 75 Light from the flash has reflected on particles in front of the camera
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 Main camera troubleshooting flowcharts

Camera hardware failure troubleshooting

Troubleshooting flow
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No recognizable viewfinder image

Troubleshooting flow

RM-132; RM-133
Camera Module Troubleshooting Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 8 –17
Copyright © 2006 Nokia. All rights reserved.



Bad camera image quality troubleshooting

Troubleshooting flow
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Camera autofocus troubleshooting

Troubleshooting flow
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LED flash troubleshooting

Troubleshooting flow
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 Front camera troubleshooting flowcharts

Front camera troubleshooting

Troubleshooting flow
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Front camera HW troubleshooting

Troubleshooting flow
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Bad image quality troubleshooting

Troubleshooting flow
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 Baseband description

System module block diagram
The device consists of two different main modules: transceiver and UI. The transceiver board consists of
baseband and RF components. The UI board consists of key domes and keypad backlights. Connection
between the UI and the transceiver board is established via a board-to-board spring connector.

Note: In this description, the user interface HW covers display, camera, keyboard, keyboard
backlight and ALS.

Figure 76 System level block diagram

Baseband functional description
Digital baseband consists of an ISA (Intelligent Software Architecture) based modem and Symbian based
application sections. The modem functionality is in RAP, and the application processor acts as a platform for
Symbian applications. The terms ISA and Symbian are used refer to the software environment of these
devices.

The modem section consists of a RAP ASIC with NOR FLASH and SDRAM memory as the core. RAP supports
WCDMA and GSM cellular protocols. The modem DDR SDRAM memory has 128 Mbits of memory and NOR flash
has 128 Mbits of memory. RAP operates with the system clock of 38.4 MHz, which comes from the VCTCXO.

The application section includes an application processor ASIC with DDR/NAND combo memory as the core.
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Application processor
The application processor is also called an application ASIC because it is processing application SW and
handles the UI SW. It consists of the application processor and peripheral subsystems such as camera, display
and keyboard driver blocks.

Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 +4.5 V Battery voltage maximum value is
specified during charging is active

Battery voltage (Call) +3.2 +4.3 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +20 V

Back-Up supply voltage 0 2.5 2.6 V Maximum capacity of the backup
power supply 4 µAh.

Phone modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC N2200 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC N2200
master reset threshold. All regulators are disabled, PurX is on low state, the RTC is on
and the oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm),
but the RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. In this mode certain regulators are
enabled and after they and RFClk have stabilized, the system reset (PurX) is released
and PWR_ON mode entered. RESET mode uses 32 kHz clock to count the REST mode
delay (typically 16 ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Voltage limits

Parameter Description Value

VMSTR Master reset threshold (N2200) 2.2 V (typ.)

VMSTR+ Threshold for charging, rising (N2300) 2.1 V (typ.)

VMSTR- Threshold for charging, falling (N2300) 1.9 V (typ.)

VCOFF+ Hardware cut off (rising) 2.9 V (typ.)
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Parameter Description Value

VCOFF- Hardware cut off (falling) 2.6 V (typ.)

SWCOFF Software cut off limit ~3.2 V

The master reset threshold controls the internal reset of EM ASICs. If battery voltage is above VMSTR, N2300
charging control logic is alive. Also, the RTC is active and supplied from the main battery. Above VMSTR, N2300
allows the system to be powered on although this may not succeed due to voltage drops during start up. SW
can also consider battery voltage too low for operation and power down the system.

Power key
The system boots up when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). Power on key is connected to the EM ASIC N2200 via PWRONX signal.

Power distribution

Figure 77 Power distribution diagram

Power supply components
• EM ASIC N2200

• EM ASIC N2300

• Application processor VCORE SMPS, N4200

RM-132; RM-133
System Module Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –9
Copyright © 2006 Nokia. All rights reserved.



• APE ADRAM LDO: N4201

• Camera and camera accelerator supplies: N6504, N6501 and N6500

• Mini SD regulator: N3500

• Flash LED driver: N6502

• Front camera regulator: N4405

All the above are powered by the main battery voltage.

Battery voltage is also used on the RF side for power amplifiers (GSM PA & WCDMA PA) and for RF ASICs.

Discrete power supplies are used to generate 2.8 V to BT, 1.5 V for the camera IO voltage, 2.8 V for the front
camera IO voltage, 1.3 V/1.5 V for the application processor and 18 V for the backlight LEDs. The device
supports both 1.8 V/3 V SIM cards which are powered by VSIM1. VSIM2 is used to enable the regulator used
to supply 3V for the mini-SD card interface.

USB accessories which need power from the device are powered by N2300 / VOUT.

The internal LED driver in N2300 is used in this engine implementation.

System power-up
After inserting the main battery, regulators started by HW are enabled. SW checks, if there is some reason to
keep the power on. If not, the system is set to power off state by watchdog. Power up can be caused by the
following reasons:

• Power key is pressed

• Charger is connected

• RTC alarm occurs

• MBUS wake-up

After that:

• N2200 activates sleep clock and VANA, VDRAM, VIO and VR1 regulators.

• Voltage appearing at N2200 RSTX pin is used for enabling N2300 ASIC.

• N2300 enables VCORE regulator and its internal RC-oscillator (600 kHz).

• VCTCXO regulator is set ON and RF clock (main system clock) is started to produce.

• N2200 will release PURX ~ 16 ms after power up is enabled (the RF clock is then stable enough).

• Synchronizing clock (2.4 MHz) for N2300 is started to be produced. After PURX is released and two rising
edges of 2.4 MHz synchronous clock have been detected in SMPSClk input N2300 starts to use that instead
of the 600 kHz internal RC-oscillator.

• HW start-up procedure has been finalized and the system is up and running. Now it is possible for SW to
switch ON other needed regulators.

Clocking scheme
There are two main clocks in the system: 38.4 MHz RF clock produced by VCTCXO in RF section and 32.768 kHz
sleep clock produced by the EM ASIC N2200 with an external crystal.

RF clock is generated only when VCTCXO is powered on by the EM ASIC regulator. The regulator itself is
activated by SleepX signals from both RAP and application processor. When both CPUs are on sleep, RF clock
is stopped.

RF clock is used by RAP, which provides (divided) 19.2 MHz SysClk further to the application processor. Both
RAP and the application processor have internal PLLs which then create clock signals for other peripheral
devices/interfaces like RS MMC, SIM, CCP, I2C and memories.

32k Sleep Clock is always powered on after startup. Sleep clock is used by RAP and the application processor
for low-power operation.
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SMPS Clk is 2.4 MHz clock line from RAP to EM ASIC N2300 used for switch mode regulator synchronizing in
active mode. In deep sleep mode, when VCTCXO is off, this signal is set to '0'-state.

BT Clk is 38.4 MHz signal from the RF ASIC to the Bluetooth system.

CLK600 is 600 KHz signal from EM ASIC N2300 to APE VCORE SMPS. The clock source is internal RC oscillator in
EM ASIC (during the power-up sequence) or RAP SMPS Clk divided by 4 after the power-up sequence.

Bluetooth
Bluetooth provides a fully digital link for communication between a master unit and one or more slave units.
The system provides a radio link that offers a high degree of flexibility to support various applications and
product scenarios. Data and control interface for a low power RF module is provided. Data rate is regulated
between the master and the slave.

USB
USB (Universal Serial Bus) provides a wired connectivity between a USB host PC and peripheral devices.

USB is a differential serial bus for USB devices. USB controller supports USB specification revision 2.0 with full
speed USB (12 Mbps). The device is connected to the USB host through the system connector. The USB bus is
hot plugged capable, which means that USB devices may be plugged in/out at any time.

SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAP and EM ASIC N2200 and of an external interface
between N2200 and SIM contacts.

The SIM IF is shown in the following figure:

Figure 78 SIM interface

IrDA interface
IrDA specifies a reliable, fully digital peer-to-peer data link between IrDA units at data rates from 9600 bits/
s to 4 Mbits/s. The link is based on the serial transmission of data as pulses of infra red light at the wave
length of 870 nm and angles of +-15 degrees at the range 0 - 50 to 100 cm. Because of these restrictions and
the optical nature of the link, the transmission is not omnidirectional but focused and only reaches a peer
at a limited line-of-sight distance from the transmitter thus not disturbing any other units in the
neighbourhood.
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SD card interface
The SD card connector is mounted on the user interface PWB. The SD card is supplied with 3 V supply voltage.
The detection of the SD card removal/insertion is done by a switch in the card connector. Removing the SD
card while writing to the card may corrupt data in the SD card.

Battery interface
The battery interface supports a 3-pole battery interface. The interface consists of three connectors: VBAT,
BSI and GND.

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Figure 79 Battery pin order

Table 19 Battery interface connections

Pin Signal I/O Engine connection Notes

1 VBAT -> EM ASIC N2200 VBAT Battery voltage

2 BSI -> EM ASIC N2200 BSI Battery size
indication
(fixed resistor
inside the
battery pack)

3 GND GND Ground

Battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line, which
is located on the transceiver PWB, at a place where the phone temperature is most stable.

For service purposes, the device SW can be forced into local mode by using pull down resistors connected to
the BSI line.

Camera interfaces

Back camera interface
The back camera of the device uses a 3.2 mega pixel camera module with auto-focus, mechanical shutter
and neutral density filter, producing pictures with a resolution of up to 2080x1560.

The regulators N9006, N6518, N6513 and N6517 power the graphics accelerator (D6500) and the camera.

Camera construction
This section describes the mechanical construction of the camera module for getting a better understanding
of the actual mechanical structure of the module.

Table 20 Camera specifications

Sensor type CMOS
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Sensor photo detectors 3 million

F number/Aperture f/3.5

Focal length 4.7 mm

Focus range Normal mode: 68 cm to infinity

Still Image resolutions 2080x1560, 1600x1200, 1280x960, 800x600,
640x480

Still images file format EXIF (JPEG), *.jpg

Video resolutions 352x288, 176x144, 128x96 all 15 frames per second

Video clip length 30 seconds or free, maximal clip length in free mode
is 1 hour

Video file format 3GPP, *.3gp or MPEG-4, *.mp4 (64 kbps in short
mode and 128 kbps in maximum mode)

Exposure Automatic

White Balance Automatic or adjustable

Colours 16.7 million / 24-bit

Figure 80 Camera module bottom view including serial numbering

Flash LED
The device back camera has a flash LED (FLED) located directly beside the camera, providing better lighting
conditions in darker environments. The same LED is also used as an indicator light to indicate video clip
recording, and to indicate when pictures are being taken as a privacy indicator.

The connections between the main PWB and the FLED are implemented with a pair of “pogo” pins shown as
X6501 on the schematic.

The FLED has four white LEDs connected in series in one module. The module also includes a lens with its
plastic housing to ensure a proper light pattern at the target.

The dimensions of the FLED are 6.5 x 7.5 x 3.5 mm.
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Figure 81 Simplified flash LED connection

Front camera
The front camera has VGA (640x480) resolution, and it is mainly used for video calls. It can also be used as a
still camera and camcorder.

The front camera is controlled and its data is collected by the application processor.

The front camera has the following characteristics:

Sensor type: CMOS

Sensor Photo detectors: VGA

F number/Aperture: f/2.9

Focal length: 4.5 mm

Still Image resolutions: 640 x 480

Video frame rate: up to 30 frames per second

Video clip length: 30 seconds or free, maximal clip length in free mode is
1 hour

Video file format: MPEG-4 *.mp4 and 3GPP, *.3gp (64 kbps in short clip
mode, 128 kbps in maximum mode)

Exposure: Automatic and manual

White Balance: Automatic or adjustable

Capture Modes: Still capture mode, video mode, sequence mode 10,20
or 30 seconds.
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User interface

User interface
The user interface of the handset consists of a complete keyboard/navi-key module connected to the engine
PWB by a flexi circuit and some parts of the engine PWB.

The user interface sections contained on the engine PWB are:

• Main power key

• Dedicated camera shutter key

• Volume/zoom keys

Slide position sensor
The position (open/shut) of the slide is detected by means of a switch on the C-cover connected to the engine
PWB by two pogo connectors.

Keyboard
The device keyboard is contained on a separate UI board. All the keys are part of the same matrix, and the
ones on the UI board are connected to the APE ASIC via Z4400 ASIP.

Table 21 Keymatrix

COL_0 COL_1 COL_2 COL_3 COL_4

ROW_0 Left soft key Right soft key Send

ROW_1 Navi select Navi left Navi up Navi down Navi right

ROW_2 7 2 3 8 Volume up

ROW_3 5 Imaging 1 6

ROW_4 9 * Operator #

ROW_5 End Camera half Camera full 4

ROW_6 0 Edit Clear Apps Volume down
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Figure 82 Keyboard layout

Main display

Display module mechanical concept

Figure 83 General diagram of the LCD module

Display features:

• Module size (width x height x thickness) 41.92 mm, 60.55 mm, 2.72 mm

• Resolution QVGA
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• Numbers of colours up to 262k

• Partial display function; power saving by pausing display process on part of the screen.

• Built-in RAM capacity 240 columns x 320 rows x 18 bits = 1,382,400 bits

The display has two different operating modes:

• Normal mode, Full screen, 262k colors

• Partial idle mode, 8 colours but only part of the display is active

The interconnection between the LCD module and the Nokia engine is implemented with a 24-pin board-to-
board connector.

The display is controlled via a MeSSi-16 interface with an 8-bit bus by the application processor. All MeSSi-16
signals go through the EMC filtering ASIPs. The display module does not require any tunings in service.

Display and keyboard backlight
The device uses a LED driver in N9002 to drive the LEDs in both the keyboards and the display. The chain of
LEDs on the UI board consists of four LEDs. In addition, there is a separate set of LEDs as part of the UI module.

Current feedback is done through the display LEDs only, with the chains being driven from the display LED
voltage through an emitter follower, controlled by BETTY_GenOut 1 into V6509 0V / 1.8 V LED control.
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Figure 84 Connections on the engine board

Figure 85 Connections on the UI board

The left-hand end of the chain connects to VLEDOUT, and the right-hand end connects to VLEDRETURN.
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ALS interface
Ambient Light Sensor (ALS) is located in the upper part of the phone. It consists of the following components:

• lightguide (part of the front cover)

• phototransistor (V6501) + resistor (R4401)

• NTC + resistors (R4400, R4402, R4403)

• Common mode filter (L7551)

• EM ASIC (N2200)

Information on ambient lighting is used to control the backlights of the phone:

• Keypad lighting is switched on only when the environment is dark

• Display backlights are dimmed, when the environment is dark

The ambient light sensor itself is a photo transistor, which is temperature-compensated by an external NTC
resistor. The EM ASIC N2200 reads the light sensor (LS) and temperature (LST) results.

ALS calibration is not possible in the service points. ALS is serviced by replacing faulty phototransistors.

ASICs

RAP ASIC
RAP ASIC is a 3G Radio Application Processor. RAM memory is integrated into RAP.

EM ASIC N2200
The EM ASIC (N2200) includes the following functional blocks:

• Start up logic and reset control

• Charger detection

• Battery voltage monitoring

• 32.768kHz clock with external crystal

• Real time clock with external backup battery

• SIM card interface

• Stereo audio codecs and amplifiers

• A/D converter

• Regulators

• Vibra interface

• Digital interface (CBUS)

EM ASIC N2300
The EM ASIC (N2300) includes the following functional blocks:

• Core supply generation

• Charge control circuitry

• Level shifter and regulator for USB/FBUS

• Current gauge for battery current measuring

• LED driver for backlights

• Digital interface (CBUS)
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Device memories

RAP memories NOR flash and SDRAM
Modem memory consists of 128 Mbit SDRAM and 128 Mbit NOR flash memories.

Combo memory
The application memory of the device consists of NAND/DDR combo memory. The stacked DDR/NAND
application memory has 512 Mbit of DDR memory and 1024 Mbit of flash memory.

 Audio concept

Audio HW architecture
The functional core of the audio hardware is built around two ASICs: RAP CMT engine ASIC and the mixed-
signal EM ASIC N2200.

There are four audio transducers:

• Dynamic earpiece

• 2 dynamic speakers

• Electret microphone module

In addition to the audio transducers, N2200 also provides an output for the dynamic vibra component.

All galvanic audio accessories are connected to the system connector accessory connector.

A Bluetooth audio module that is connected to RAP supports Bluetooth audio functionality.

There is a separate application processor for Symbian applications.
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Figure 86 Audio block diagram

Internal microphone
The internal microphone is used for HandPortable (HP) and Internal HandsFree (IHF) call modes.

An analogue electret microphone is connected to the EM ASIC (N2200) Mic1P and Mic1N inputs via asymmetric
electrical connection.

The microphone is biased by the EM ASIC MicB1 bias voltage output.

Figure 87 Internal microphone circuitry

External microphone
Galvanic accessories are connected to the system connector.
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Accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

A dynamic earpiece capsule is connected directly to the EM ASIC (N2200) differential outputs EarP and EarN.

Figure 88 External microphone circuitry (system connector connects to the right side)

Internal earpiece
The internal earpiece is used in the HandPortable (HP) call mode. A dynamic earpiece capsule is connected
directly to the EM ASIC (N2200) differential outputs EarP and EarN.

Internal speaker
The internal speakers are used in Internal HandsFree (IHF) call mode.

Two dynamic speakers are connected to the N6509 dual amplifier.
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Figure 89 Internal speaker circuitry

External earpiece
All galvanic accessories are connected to the system connector.

The accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

N2200 provides two output channels in either single-ended or differential format. N2200 outputs XearL and
XearLC for the left channel audio output, and XearR and XearRC the right channel audio output. XearLC and
XearRC are the ground pins if using single-ended mode. On the system connector side, HSEAR_P and HSEAR_N
form the left channel output, and HSEAR_R_P and HSEAR_R_N the right channel output. HSEAR_N and HSEAR_R_N
are the ground pins in single-ended mode.
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Figure 90 External earpiece circuitry

Vibra circuitry
Vibra is used for vibra-alarm function.

The vibra motor is connected to the EM ASIC (N2200) VibraP and VibraN Pulse Width Modulated (PWM) outputs.

Figure 91 Vibra circuitry

The vibra is soldered onto the engine PWB.

System connector
The system connector provides a fully differential 4–wire stereo line-level output connection and a fully
differential 2-wire mono line-level or microphone level input connection.

The handsfree driver in one of the EM ASICs is meant for the headset.
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The output is driven in a fully differential mode. In the fully differential mode, the handsfree pin is the
negative output and the HFCM pin is the positive output. The gain of the handsfree driver in the differential
mode is 6 dB.

The earpiece and headset signals are multiplexed so that the outputs cannot be used simultaneously.

Figure 92 External audio connector

Table 22 Audio connector pin assignments

Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or
nominal serial

impedance

Notes

1/ Charge V Charge DC 0-9V/ 0.85A

2/ GND Charge GND - 0.85A 100mΩ (PWB+
conn.)

3/ ACI ACI 1kbits/s Digital 0 / 47Ω Insertion &
removal
detection

2.5-2.78V

4/ Vout DC out DC 2.78V 70 mA 100mΩ (PWB+
conn.)

200mW

2.5V 90mA

9 / XMIC N Audio in 300-8k 1Vpp &

2.5-2.78VDC

10 / XMIC P Audio in 300-8k 1Vpp &

2.5-2.78VDC

11 / HEAR N Audio out 20-20k 1Vpp 10Ω

12 / HEAR P Audio out 20-20k 1Vpp 10Ω

13 / HEAR R N Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

14 / HEAR R P Audio out 20-20k 1Vpp 10Ω Not conn. in
mono
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 Baseband technical specifications

External interfaces

External interfaces

Name of Connection Connector reference

USB X2001

Charger X2000

Headset X2001

SIM X6513

MiniSD X1001

Battery connector X6512

VOUT electrical characteristics

Description Parameter Min Max Typical Unit Notes

Vout
regulator
for
external
accessories

VOUT 2.43 2.57 2.5 V Max load
90mA

SIM IF connections

Pin Signal I/O Engine connection Notes

C1 VSIM Out EM ASIC N2200 VSIM1 Supply voltage
to SIM card,
1.8V or 3.0V.

C2 SIMRST Out EM ASIC N2200 SIM1Rst Reset signal to
SIM card

C3 SIMCLK Out EM ASIC N2200 SIM1ClkC Clock signal to
SIM card

C5 GND - GND Ground

C7 SIMDATA In/Out EM ASIC N2200 SIM1DaC Data input /
output

SW SIM_DET In EM ASIC N2200 SIMDetX Removal
detection

RM-132; RM-133
Nokia Customer Care System Module

Page 9 –26 COMPANY CONFIDENTIAL Issue 1
Copyright © 2006 Nokia. All rights reserved.



Charger connector and charging interface connections & electrical characteristics

Figure 93 Charger connector

Table 23 Charging interface connections

Pin Signal I/O Engine connection Notes

1 Vchar In N2300 VCharIn1, 2 Charging
voltage /
charger
detection,
Center pin

2 Charge GND Ground Charger
ground

Table 24 Charging IF electrical characteristics

Description Parameter Min Max Unit Notes

Vchar V Charge 0 9 V Center pin

Vchar I Charge 0.85 A Center pin

Charge GND 0.85 A

Threshold for
charging,
rising (N2300)

VMSTR+ 2.1 V Typical value

Threshold for
charging,
falling (N2300)

VMSTR- 1.9 V Typical value
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Internal interfaces

Internal interfaces

Name of connection Connector reference

UI connector X6515

Back camera X6523

Front camera X6522

Flash connector X6501

Power key X6526, X6527

Display connector X6507

Slide switch X6530, X6531
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UI module connector and IF connections

Figure 94 Back side of the board
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Figure 95 Front side of the board

Keyboard interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

High-level
input voltage

VIH 0.65* VDDS VDDS 0.3+ VDDS V Row

Low-level
input voltage

VIL -0.3 0 0.35* VDDS V Row

High-level
output
voltage

VOH 1.62 VDDS 1.98 V Column
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Description Parameter Min Typ Max Unit Notes

Low-level
output
voltage

VOL 0 0.45 V Column

(VDDS = 1.8V)

Keyboard connector and interface connections

Pin Signal I/O Engine
connection

Notes

1 VLEDOUT O N2200

6 Dat3/CD I/O APE MiniSD

7 CMD I/O APE MiniSD

8 CLK I/O APE MiniSD

9 Row 0 APE

10 Dat0 APE MiniSD

11 Dat1 I/O APE MiniSD

12-16 GND

17 Dat2 I/O APE MiniSD

18 GND

19 Card Detect I APE MiniSD

20 VSD Power MiniSD

21 Column 4

22 Column 3

23 Row 4

24 Column 0

25 Row 5

26 Row 6

27 GND

28 Row 2

29 Row 1

30 Row 3

31 Column 1

32 VLED return

33 Column 2

34 GND
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Back camera electrical characteristics

Table 25 Camera CCP IF electrical characteristics

Description Paramete
r

Min Typ Max Unit Notes

Common mode voltage VCMF 0.8 0.9 1 V -1

Differential voltage
swing

VOD 100 150 250 mV -2

Operating frequency fCLK 1 175 MHz SW controls
frequency

Differential rise and fall
time

300 800 ps -3

Note:

• Common mode voltage is a mean value of high and low states of one single-ended signal.

• Differential voltage swing is differential amplitude between signals of differential pair.

• Differential transitions should be only measured with good equipment (bandwidth > 1 GHz),
otherwise results will seem too slow.

Table 26 Camera supply voltage characteristics

Description Parameter Min Typ Max Unit

Camera analogue
voltage

VDD 2.37 2.5 2.63 V

Camera digital voltage VDDI 1.4 1.5 1.65
V

V

Front camera electrical characteristics

Table 27 Front camera supply voltage characteristics

Description Parameter Min Typ Max Unit

Camera I/O and
photo sensor
voltage

VCAM2 2.6 2.8 3 V

Camera digital
circuits and A/
D converter
voltage

VCAM 1.4 1.5 1.6 V

Flash LED interface and electrical characteristics

Table 28 Flash LED interface connections

Signal name From To Description

GPIO28 D4800 N1471 Indicator mode enable
signal
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Signal name From To Description

ARMIO4 D4800 N1471, V1472 Flash mode enable test
signal (only test use)

VBAT Battery N1471 Battery nominal voltage

STROBE Camera N1471, V1472 Flash light enable signal
from back camera

Table 29 Flash LED interface electrical characteristics

Description Parameter Min Typ Max Unit

GPIO28 GPIO output 1.72 1.8 1.92 V

ARMIO4 GPIO output 1.72 1.8 1.92 V

STROBE Strobe signal
output

2 - 2.5 V

Slider switch electrical characteristics

Signal name From To Low value High value Description

GPIO53 Application
processor

S5202 160 mV 1.8 V Slider switch
cover status
signal.

Back-up battery interface connections and electrical characteristics

Table 30 Back-up battery connections

Pin name I/O Connection Notes

L2207,
VBack

-> N2200,
VBack

Back-up battery G2200 is
connected to N2200 via coil

Table 31 Back-up battery electrical characteristics

Description Parameter Min Typ Max Unit

Back-Up
Battery
Voltage

Vback 0 2.5 2.7 V

 RF description

RF introduction
The RF is controlled by digital baseband circuitry via a serial bus (RFBus). The RFBus is for mode selection,
frequency synthesizer control, RX AGC setting, RF regulator control, TX power control loop and PA bias control.
In addition to RFBus there are also several other interface signals coming from BB. TX power control (TXC),
VCTCXO frequency control (AFC) and some other control signals (voltage and current references, WCDMA TX
power detection, PA combination detection).
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Regulators
All RF regulators, except one, are located in the EM ASIC N2200 in the baseband section or in the RF ASIC of
the device. The discreet regulator, N7541, feeds the WCDMA PA. The EM ASIC N2200 has three regulators for
RF:

• 2.5 V regulator VXO

• 4.75 V regulator VCP (VCP1 & VCP2)

• 1.35 V regulator, VB_EXT, which is the reference voltage.

RF block diagrams
The RF block diagram for RM-133 uses RF ASIC N7500 as illustrated by the red border in the block diagram.

Figure 96 RM-133 RF block diagram

The RF block diagram for RM-132 is the same as for RM-133 except all WCDMA specific components have been
removed.
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Figure 97 RM-132 RF block diagram

Single feed switch
In RM-133, the single feed antenna switch directs the received signal from the multiband antennas to either
the GSM or the WCDMA section. In the case of RM-132, the WCDMA switch output is terminated by a matched
load. The GSM section covers the four GSM bands USGSM850, EGSM900, GSM1800 and the GSM1900. The WCDMA
section operates at the 2100 MHz band. In the transmit direction the switch takes the transmit signal from
either the GSM band or the WCDMA band to the single feed multiband antenna.

Frequency plan
Both, the receiver and the transmitter, are based on direct conversion architecture. The VCOs operate at the
channel frequency multiplied by two or four depending on the band of operation. This means that the
modulated baseband signals are directly converted up to the transmission frequency and the received RF
signals directly down to the baseband frequency.
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Figure 98 RF frequency plan

Receiver

Introduction to receiver functionality
The receiver is a linear direct conversion receiver containing LNA, band pass filter and demodulator for each
supported system and band. After the demodulators the signal paths are combined to one common BB path.

WCDMA receiver
In the WCDMA mode, the received signal is fed from the antenna to the single feed switch, which routes the
received WCDMA signal to the SAW duplex filter. From the duplex filter, the signal goes through a balun to
the integrated LNA in the RF ASIC. From the LNA, the signal goes through a band pass filter. After filtering,
the signal goes to the down conversion mixer, which converts the signal into baseband I and Q signals.

At BB frequency the signal is amplified and fed to a low pass filters.
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The filter is followed by an AGC amplifier with adjustable gain. The signal is further amplified before it is fed
to balanced analog IQ output pins. Analogue output pins are accompanied by reference voltage output, which
sets the DC level for the AD converter in BB ASIC.

GSM receiver
As GSM Rx branches are functionally identical, the following description is applicable to all of them.

The received signal goes from the GSM antenna to the single feed switch, which routes the received GSM
signal to a front-end module, containing a PIN diode switch matrix. The switch matrix is used for the GSM
band as well as for the Rx/Tx selection.

The switch matrix is followed by integrated LNA stages in the RF ASIC. The LNAs are followed by demodulators
which down-convert the signal to baseband I and Q signals.

In the BB-chain there are two adjustable gain stages and one mode specific gain. The first one called BB-gain
is just after the demodulator. It has a 12 dB gain range with 6dB steps. After the BB-gain there is the channel
select filter.

The main AGC amplifier precedes the channel selection filter. It has 30 dB of gain control range with 3 dB
steps. The final amplifier stage is used as an output buffer for IQ signals. This stage is set to 0 dB gain in the
GSM mode.

Transmitter

Introduction to transmitter functionality
Transmitter functions are implemented in the RF ASIC N7500.

The RF ASICs contain a BB frequency low pass filter, which is tuneable according the signal bandwidth of the
system in use. In addition, they both contain three separate RF paths (GSM850/900, GSM1800/1900 and
WCDMA) comprising of a final frequency IQ modulator and VGA amplifiers.

WCDMA transmitter
In the transmitter side, an analogue I/Q modulated signal is fed from the digital baseband into the RF ASIC
and through the low pass filter. After the filter the signal is fed to the I/Q modulator, which converts the
signal to final TX frequency. There are two separate I/Q modulators, one for WCDMA and another for GSM850/
EGSM900 and GSM1800/1900 signals. The WCDMA branch is selected by biasing the appropriate modulator.
The modulator is followed by two VGA stages. The signal then exits the RF ASIC via a balanced line. The signal
is band pass filtered by a SAW filter before it is fed to WCDMA PA module.

After the PA, the transmitted WCDMA signal is fed through the duplex filter to the single feed antenna switch
and then to the antenna.

WCDMA power control
WCDMA TX power control is performed by the two VGA stages in the RF ASIC.

The gain of VGA amplifier chain is controlled by a DA converter in BB. The same DA converter is shared by GSM
TX power control function.

WCDMA PA module
WCDMA PA is housed in a separate module having a variable supply voltage input for the amplifier stages
(Vcc11), a battery supply voltage for the bias circuits (Vcc12) and one bias current input. Bias current is
generated by 5 bit DA (DAC201) converter in RF ASIC N7500. The converter is controlled via RFBus.

In production the PA quiescent current can be tuned to target value by adjusting the bias current of PA output
stage. The bias current is also used as PA on/off controls.
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PA DCDC converter
The DCDC converter is controlled by 5 bit DA (DAC101) converter in RF ASIC N7500. The converter is controlled
via RFBus. The DCDC converter limits the lowest supply voltage to 1.3 V. At the highest power levels, the DCDC
converter output settles nominally to 3.1 V.

GSM transmitter
An analogue IQ modulated signal is fed to the RF ASIC from Digital BB. It is first low pass filtered then routed
to the GSM modulator. The appropriate routing after the modulator is selected by biasing either GSM850/
EGSM900 or GSM1800/1900 variable gain amplifier.

After the VGA stage, the signal exits the RF ASIC. In case of GSM1800/1900, the signal goes directly to the GSM
PA module. In case of GSM850/EGSM900, the PA module is preceded by a switchable SAW filter. After the filter,
the signal is fed to GSM TX front-end module (TXFEM), which also contains the switch matrix. It routes the
output GSM signal to the single feed antenna switch and then to the antenna.

GSM PA module
The TXFEM module contains two separate amplifier chains, one for GSM850/EGSM900 and another for
GSM1800/1900. Both amplifiers have a battery supply connection and two bias current inputs.

Frequency synthesizers
There are two separate synthesizers for WCDMA Rx and WCDMA Tx / GSM Tx / Rx. This allows the duplex
separation to be set according the network settings in the WCDMA mode.

The VCOs are locked by PLLs into a reference oscillator, VCTCXO (Voltage Controlled Temperature Compensated
Crystal Oscillator).

The PLLs are located in RF ASICs and controlled via RFBus.

Reference oscillator
A 38.4MHz VCTCXO is used as a reference oscillator for the frequency synthesizers.

The frequency of the reference oscillator is locked into the frequency of the base station with the help of an
AFC voltage, which is generated in BB by DSP and converted by dedicated DAC.
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 Frequency mappings

GSM850 frequencies
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EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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WCDMA 2100 Rx frequencies
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WCDMA 2100 Tx frequencies
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10  — Schematics
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